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Workforce Management 8.5 Supervisor
Help
Welcome to the Workforce Management (WFM) Supervisor Help. Use this page to go directly to the
information you need, or use the Table of Contents to take a step-by-step tour of all the features and
functions in WFM Supervisor interface.

Tip
This Help describes the latest UI for the Workforce Management (WFM) Forecast,
Performance, and Calendar modules (introduced in 8.5.2). If you are using the classic
Supervisor interface and have landed on this page by accident, see Workforce
Management Web for Supervisors (Classic) Help, which describes the classic Forecast
module, Calendar module, Performance module, and all other modules in WFM Web.

Getting Started

Learn how to navigate WFM Web, logging in/out, and about its controls and settings.

• WFM Web: What you should know
• Logging in and out
• Common controls in the UI

Tour the latest WFM Forecast Interface
Link to video
Take a video tour of the features and controls of the latest WFM Forecast interface.

Forecast Scenarios
Create forecast scenarios, build volumes,
staff, and publish forecasts.

Forecast Overlays, Events, and
Templates
Create overlays, overlay events, and
templates in forecasts.

Workforce Management 8.5 Supervisor Help
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Learn about the latest WFM Calendar Interface

About Forecast scenarios
Volumes in scenarios
Staffing in scenarios
Shrinkage in scenarios

Overlays
Overlay events
Templates

Master Forecasts
View Master Forecast volumes, staffing,
and shrinkage data.

About Master Forecasts
Volumes in the Master Forecast
Staffing in the Master Forecast
Shrinkage in the Master Forecast

Calendar Items
Create and manage calendar items.

About Calendar Items
Add Calendar Items
Edit Calendar Items
Update Schedule

Time-Off Limits
Set time-off limits

About Time-Off Limits
Set Values Dialog
Set Time-Off Limits Wizard
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Learn about the latest WFM Performance Interface

Performance views
View performance statistics for business
units, sites, and activities:

About Performance views
Monitor view
Intra-Day table view
Alerts view
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Workforce Management Supervisor Help 5



Overview

Tip
This page is an overview of the latest UI for the Workforce Management (WFM)
Forecast, Performance, and Calendar modules (introduced in 8.5.2). If you are using
the classic Supervisor interface and have landed on this page by accident, see the
Overview page in the Workforce Management Web for Supervisors Help (Classic),
which describes all modules , including the classic Forecast module, classic
Performance module and classic Calendar module.

This Help provides a comprehensive guide to the features and functions of the latest UI of WFM
Supervisor Forecast, Performance, and Calendar modules. In addition, it offers some general
guidance on using web browsers. If you require more assistance on using your web browser, refer to
the browser's help system.

Supervisor Help Topics

The red underlined links below will take you directly to a topic. Links are available throughout the
Supervisor Help to give you easy access to information.

Getting Started

Explains some WFM Web basics such as security
features, accessibility, limitations in browsers,
setting the clock, where to find a Glossary of Terms,
and links to information about other WFM
Supervisors modules.
Sub topics include logging in and out of WFM and a description
of common controls in the interface.

Forecast Module Explains how to make workload and staffing
forecasts or predictions for one or more sites.

Performance Module Allows you to view performance statistics for
business units, sites, and activities.

Calendar Module
Explains how to view, add, edit, and delete
preplanned items, such as exceptions and
preferences; how to grant or decline these items;
and how to set time-off limits.
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Printing this online Help

If you prefer to print the Help rather than use it online, complete the following steps:

1. In the upper-right section of the page, click Download a PDF.
2. In the drop-down menu, select one of two options:

• PDF this manual
• PDF this page

3. When the dialog open, select of the following:
• Open with to select the application, with which you want to view and print the Help (Adobe Acrobat

v9 is recommended).
• Save File to save the Help to a folder on your computer.

4. When the download is complete, open and view the file on your computer offline, or navigate to the

Overview

Workforce Management Supervisor Help 7



folder where you saved the .pdf file and use the Print function in your application to print the file.

Overview
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Getting started

Tip
This page is an overview of the latest UI for the Workforce Management (WFM)
Forecast, Performance, and Calendar modules (introduced in 8.5.2). If you are using
the classic Supervisor interface and have landed on this page by accident, see the
Overview page in the Workforce Management Web for Supervisors Help (Classic),
which describes all modules , including the classic Forecast module, classic
Performance module and classic Calendar module.

Site supervisors can use a web browser to log in to WFM Web for Supervisors and perform the
following tasks:

• Add availability, days off, exceptions, shifts, time off, and working hours.
• Edit agent exceptions, preferences, and time off.
• Review rotating patterns.
• Forecast staffing requirements, based on service objectives and historical data.
• View performance statistics for business units, sites, and activities.

Security features

WFM Web includes security features that prevent unauthorized access to information. You can view
and make changes only to those modules and objects (such as business units or sites) for which you
have security access. You cannot access other modules or objects.

Using multiple browser windows

If you are using Mozilla Firefox, Genesys recommends that you not run WFM Web in more than one
browser window on the same workstation, because doing so can cause the application to behave in
unexpected ways.

If you are using Internet Explorer, Genesys recommends (for the same reason) that you not open a
second browser window on the same WFM Web session by selecting File > New or pressing Ctrl+N.
However, starting a separate WFM Web session by launching a separate Internet Explorer browser
thread does not appear to cause this problem.

Getting started
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Setting the clock

WFM Web for Supervisors picks up the regional settings or locale from the browser language settings.
You may wish to change this if, for example, WFM Web appears in a 12-hour format and you want to
view a 24-hour format.

Glossary of Terms

The terms and acronyms that are used throughout the WFM documentation appear as links that
reference a glossary containing their definitions. You can view these definitions by clicking the link,
which opens in a pop-up window on the page you are viewing. For example, average handle time.

Also, see the entire Genesys Glossary.

Links to more information

The new Supervisor interface currently contains the Performance, Forecast, and Calendar modules
only. Other modules are currently under development.

Logging in and out Explains how to start your WFM Web session.

Common controls Explains the layout and functions of the WFM Web
controls in the new Supervisor interface.

Forecasts
Explains how to forecast staffing requirements
based on projected interaction volumes and service
objectives.

Performance Allows you to view performance statistics for
business units, sites, and activities.

Calendar
Explains how to view, add, edit, and delete
preplanned items, such as exceptions and
preferences; how to grant or decline these items;
and how to set time-off limits.

Getting started
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Logging in and out

Tip
This page is an overview of the latest UI for the Workforce Management (WFM)
Forecast, Performance, and Calendar modules (introduced in 8.5.2). If you are using
the classic Supervisor interface and have landed on this page by accident, see the
Overview page in the Workforce Management Web for Supervisors Help (Classic),
which describes all modules , including the classic Forecast module, classic
Performance module and classic Calendar module.

Before you can log in to WFM, you must have the WFM Web URL (address). In some contact centers,
the Log in page might be set up and ready for you to enter your username and password. If this is not
the case, ask your administrator for the WFM Web URL. After typing it into your browser, WFM
displays the splash screen for the Log in user interface (UI).

Tip
WFM has a new Supervisor interface that you can access after logging in to Web for
Supervisors (if you have the appropriate access rights). To use the new interface, see
Opening the new Supervisor UI.

Getting started Logging in and out
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Logging in to WFM

To start using WFM:

1. Obtain the URL (address) for the WFM application from your administrator.
2. Open a web browser.
3. Copy and paste or type the URL into your browser's address bar and press Enter.

The Log in window appears.
4. Enter your user name and password.
5. Click OK.

If WFM Web validates your user name and password, the Supervisors (Classic) Home view opens. If
WFM cannot log you in, it displays an error message indicating the problem. Either click Login to try
again (for example, if you think that you typed an incorrect user name or password), or click Show

Getting started Logging in and out
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error details.

Important
When using the Firefox web browser, ensure multiple supervisors are not logged in to
the same host at the same time.

Opening the latest Forecast UI

Depending on how WFM Web is set up in your contact center, you might or might not see the option
to open the New UI. If you do not see this option and require access permission, contact your
administrator.

Getting started Logging in and out
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To open the new Forecast UI:

1. First, log in to the Supervisors (Classic) interface. See the procedure above.
2. In the top-right corner of the classic Home view (or any view), click New UI.

The new UI for all available modules are displayed.
3. Click the Forecast drop-down menu to select and open any view in the Forecast module.

Tip
You can switch to the classic Supervisor UI at anytime by clicking the Log in/Log out
drop-down menu and selecting Switch to classic UI.

Getting started Logging in and out
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Opening the latest Performance UI

Depending on how WFM Web is set up in your contact center, you might or might not see the option
to open the New UI. If you do not see this option and require access permission, contact your
administrator.

To open the new Performance UI:

1. First, log in to the Supervisors (Classic) interface. See the procedure above.
2. In the top-right corner of the classic Home view (or any view), click New UI.

The new UI for all available modules are displayed.
3. Click the Performance drop-down menu to select and open any view in the Performance module.

Tip
You can switch to the classic Supervisor UI at anytime by clicking the Log in/Log out

Getting started Logging in and out
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drop-down menu and selecting Switch to classic UI.

Opening the latest Calendar UI

Depending on how WFM Web is set up in your contact center, you might or might not see the option
to open the New UI. If you do not see this option and require access permission, contact your
administrator.

To open the new Calendar UI:

1. First, log in to the Supervisors (Classic) interface. See the procedure above.

Getting started Logging in and out
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2. In the top-right corner of the classic Home view (or any view), click New UI.
The new UI for all available modules are displayed.

3. Click the Calendar drop-down menu to select and open any view in the Calendar module.

Tip
You can switch to the classic Supervisor UI at anytime by clicking the Log in/Log out
drop-down menu and selecting Switch to classic UI.

Changing the local timezone

WFM enables you to view your user settings and change your timezone in the User Settings dialog
by clicking the Log in/Log out drop down menu.

Getting started Logging in and out
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To change your timezone:

1. In the upper-right corner of any view, click the down arrow beside your username.
2. Select User settings...

The User Settings dialog opens.
3. Click the Time Zone drop-down menu and select your timezone.
4. Click Save.

You can also view your first name, last name, email address, and WFM security role in this dialog,

Getting started Logging in and out
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although you cannot change these settings.

Logging out

Always log out when you have finished using WFM. If you do not log out, other users of your
workstation might be able to view your account information.

To log out of WFM:

1. Click the down arrow beside your name to open the drop-down menu.
2. Select Log out.

WFM Web logs you out and the Login screen appears.

Another user can now log in or you can close the browser.

Getting started Logging in and out
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Common controls in the UI

Tip
This page is an overview of the latest UI for the Workforce Management (WFM)
Forecast, Performance, and Calendar modules (introduced in 8.5.2). If you are using
the classic Supervisor interface and have landed on this page by accident, see the
Overview page in the Workforce Management Web for Supervisors Help (Classic),
which describes all modules , including the classic Forecast module, classic
Performance module and classic Calendar module.

The views and panes in the WFM Supervisor interface display some combination of the controls
described below, depending upon selections that you make in the Objects pane.

Buttons and icons The following buttons and icons appear at the WFM
interface:
Log Out closes WFM Web, without confirming your
choice if there are no changes to save.
Option menu enables you to select from a list of
view-specific commands. This menu's contents
change as you move among modules and views,
and often match the command icons that appear
on the toolbar.
Help icon opens WFM Web Help at the view-level
topic. For example, if you open Forecast >
Scenarios and click this icon, the Help topic
opens, describing the Scenarios view.
Contextual Help button opens WFM Web Help at
the wizard or dialog topic. For example, if you click
this button in a wizard or dialog, the Help topic
opens, describing the wizard or dialog.
Search icon enables you to enter search criteria to
quickly find the object you are looking for. The
criteria you enter will depend on which pane you
have open. Result that are found to match the
search criteria are highlighted.
Sort button enables you to sort lists to easily find
the items you are looking for. The sorting criteria
will vary, depending on which pane you have open.

Date selectors enable you to change the date or
date range in a view. See more below.

Paging controls enable you to browse the
previous and next pages or navigate to the first
and last items in the data set (start and end of the
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list), by clicking the appropriate arrow button in the
view. To navigate between pages, you can use the
Up, Down, Page Up, and Page Down keys on the
keyboard.
Rows per page selector enables you to choose
the number of table rows you want to see on a
page. Use the drop-down menu to select 5, 25, 50,
and 100 rows per page.

Modules and Views

Click to open a drop-down list of views in the WFM
module: Forecast. The views include:

• Forecast Scenarios
• Master Forecast > Volumes
• Master Forecast > Staffing
• Master Forecast > Shrinkage
• Templates
• Overlays

Click to open a drop-down list of views in the WFM module:
Performance. The views include:

• Monitor
• Intra-Day
• Alerts

Click to open a drop-down list of views in the WFM module:
Calendar. The views include:

• Calendar Items
• Time-Off Limits

Actions Toolbar

The buttons on the toolbar (often, not always)
correspond to the commands on the Option menu.
Hover your mouse pointer over a toolbar button to
see a tool tip that displays the button's name. See
an example.

Objects Pane

This pane offers several different display schemes,
depending on the current selection of tab and
menu item:
Tabs: module-specific item trees under separate tabs
One tree: Business Units (BUs) > Sites
One tree: BUs > Sites> Activities
Upper tree: BUs > Sites> Teams > Agents
Lower tree: BUs > Multi-site Activities > Activity Groups >
Sites > Activities

When there are two selecting items in either of these two trees,
it triggers an automatic selection of corresponding items in the
other tree.

At the site level, you may see a team in the tree labeled
<None>. This node lists any agents that are assigned to the site,
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but not assigned to a team. If all agents in that site are assigned
to a team, then the <None> team is empty. The only exceptions
to this hierarchy are when Scenarios is selected or when you
use the Configuration or Reports modules.

Clicking an object in a tree (or clicking its expand/collapse
control) displays the object's contents below it, indented slightly.
When you have displayed the desired object, double-click it (or
click it once, and then click Get data) to open the selected view
for that object.

Where the Objects tree displays check boxes, you can usually

select / deselect multiple objects by selecting ( ) / clearing

( ) their check boxes, respectively. Certain views do not
display check boxes; in this case, you can select multiple objects
by clicking the group of objects while pressing the SHIFT or
CTRL key. Some views and windows allow you to select only a
single object.

Expand/Collapse Controls

Wherever you see the icon in a tree or other
control, you can click it to see an expanded view of
the adjacent item's contents or details. The icon
indicates an expanded item. Click it once to
collapse the item's contents and see more parallel
items.

Action Buttons

View-level action buttons within the working pane
provide controls that are specific to particular views
(for example, apply or cancel).

The Get data button , when present at
the lower left below the Objects tree, refreshes the
display with current data from the database.

Tip
Not all modules use the Get data button. If there is no
Get data button, the view is automatically updated
with the new data every time that you change your
date or object selection.

Date selectors

Many WFM Web modules and views have common date-selection controls to modify the date or date
range displayed in them. Use these controls to:

• Select a start date.
• Jump to other dates by opening the monthly calendar.

Also, learn how WFM Web automatically selects the first workday in weekly views.

Getting started Common controls in the UI
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Selecting the start date
Where available, the date-selection controls appear at the right-most end of the toolbar.

Use these controls as follows:

• Click the left angle bracket to move the start date back one interval (day, week, or schedule planning
period—depending on the context), and the right angle bracket to move the start date forward one
interval.

• Type a date into the date box or use the up and down arrows to edit the start date. (The sequence of
month, day, and year digits depends on your operating system's regional settings.) See also, weekly
views.

• Click the Calendar icon to open the monthly calendar.

Date selection controls include the end date in views that display information for more than one day,
but you cannot modify it.

Selecting the month

Clicking the Calendar icon opens the one-month calendar. You can use the calendar's controls to:

• Find the current start date—The currently-selected start date is indicated by a dark blue square.
• Select a new start date—Click a date to adjust the start date in the current module or view.
• Move forward or backward one month—Click the left or right arrows in the calendar header.

Getting started Common controls in the UI
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Weekly views: automatic start day selection
In weekly views, if you enter a date other than the first weekday, the view automatically adjusts to
start with the first weekday.

The first weekday is the one specified in Week start day in the Business Units Properties tab.

Getting started Common controls in the UI
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Calendar

Tip
This page describes the new Workforce Management (WFM) Calendar module
interface (introduced in 8.5.2). If you are using the classic Supervisors interface and
have landed on this page by accident, see the Workforce Management Web for
Supervisors Help (Classic), which describes the classic Calendar module.

The Calendar module contains two sub-modules:

• Select Calendar items to:
• Add availability, days off, exceptions, shifts, time off, and working hours.
• Edit agent exceptions, preferences, and time off.
• Review rotating patterns.
• Change the time zone to view Calendar items' times in the selected by user time zone.

• Select Time-Off Limits to set time-off limits.

Getting started Calendar

Workforce Management Supervisor Help 25

https://docs.genesys.com/Documentation/WM/8.5.2/SHelp/Welcome
https://docs.genesys.com/Documentation/WM/8.5.2/SHelp/Welcome
https://docs.genesys.com/Documentation/WM/8.5.2/SHelp/CalendarMdl


Calendar Items

Tip
The Calendar module includes Calendar Items (this topic) and Time-Off Limits.

The toolbar buttons are across the top of the window. The Agents and Activities trees are at the
Objects pane.

Use the Calendar Items module to add, and edit agents' exceptions, preferences, and time off.

• Exceptions are periods of time when agents are engaged in non-work activities.
• Preferences are agent and supervisor requests for particular shifts, days off, availability, and time off.
• Rotating patterns are rotating work weeks of shifts, working days, working hours, and/or work activities.

A rotating pattern can be assigned to an agent.

Calendar Module Controls

Toolbar Buttons
Select a view from the Calendar drop-down (on the left side of the toolbar): Calendar Items or Time-
Off Limits.

Icon Name Description

Filter Filter the display.

Add Add an item (in this view, a
calendar item).

Edit Edit the selected calendar
item(s).

Prefer
Change the status of the
selected agent request(s) to
Preferred.

Getting started Calendar Items
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Icon Name Description

Grant
Change the status of the
selected agent request(s) to
Granted.

Decline Decline the selected agent
request(s).

Delete Remove the selected calendar
item(s).

Update Schedule

Insert time-off items and
meeting-specific criteria to the
master schedule. (You must be a
supervisor with edit rights to the
master schedule.)

Option menu

Select whether to include these
columns in the table: Site, Team,
Shared Transport, Site Date,
Reason, Comments/Memo, Paid
Hours, Hire Date, Submitted, Site
Time Zone. This menu is
displayed on the right side of
toolbar.

Help Display context-sensitive help.

Time Zone
Select the time zone for this instance of WFM by using the drop-down list that appears on the right
side of the toolbar buttons and above the calendars. The following choices appear in the list:

• User’s—Specifies the time zone of the current user, as configured for that user in WFM Web.
• If no time zone is configured for the current user, this option is absent.

• BU/Site—
• Specifies the time zone of the BU that is selected on the Object pane.
• Specifies the time zone of the site that is selected on the Object pane. If more than one site is

selected, then WFM specifies the time zone of the BU that is selected on the Object pane.

• Local —Specifies that data for every site will be returned in that site's local time zone.
• Configured time zones—Specifies the time zone that you choose from the remainder of items in this

list.
• Each remaining item is a configured time zone (and its relationship to GMT). For example, Pacific

Standard Time, which is 8 hours earlier than Greenwich Mean Time, is presented in the Internet
Assigned Numbers Authority (IANA) standard as (GMT -08.00) US/Pacific.

Getting started Calendar Items
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Objects Pane
The Objects pane, on the left side of the WFM window, displays the database objects that you can
retrieve.

Agents Tree
The Agents tree displays agents in the Enterprise. The tree is hierarchical from top to bottom:
Business Units, Sites, Teams, and Agents.

Activities Tree
The Activities tree displays activities in the Enterprise. The tree is hierarchical from top to bottom:
Business Units, Multi-site Activities, Activity groups, Sites, and Activities.

Each item in the Object trees has a check box, which is either cleared or selected. Checking an item,
in one of the trees causes a reaction in the other tree: selecting an agent automatically selects the
corresponding activities, and selecting an activity automatically selects the corresponding
agent(s)/team(s)/site(s)/business unit.

Tip
You can simultaneously select items that are located below different sites within the
same business unit. Nothing is selected by default.

About the Calendar Items Module

The Calendar Items module displays agents' shifts, days off, time off, exceptions, and availabilities.
You can filter this display. You can add and edit most types of Calendar items from this display, and
you can edit exceptions, working hours, shifts, and availabilities.

Rotating pattern information is read-only. Rotating patterns appear with an RP: prefix. To change
rotating pattern settings, you must use the Rotating Patterns pane in the Policies module as
described in the Workforce Management Web for Supervisors Help (Classic).

Calendar Module Security

The WFM Web defines security access permissions. Users may have full security access to this
module, or they may only be able to work with preferred Calendar items.

If you have limited access, then the Grant, Prefer, and Decline buttons are disabled. You can only
add, edit, or delete calendar items in Preferred status.
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Displaying the Calendar View
To view Calendar items:

1. If the Calendar Items module is not displayed, select Calendar from the Views menu.
2. In the three-month Calendar display, select the date(s) to view. Shift-click selects multiple dates.
3. Click Get data below the Object pane.

Calendar View Columns
Name Description

Site Displays the site to which the Agent in this row
belongs.

Team Displays the team to which the Agent in this row
belongs.

Agent
Displays the name of the agent who has the
Calendar item. Calendar items can be applied to
sites or teams, but they are displayed and edited
agent-by-agent.

Shared Transport Displays the shared transport to which the agent in
this row is joined

Type Displays the type of the Calendar item (for
example, part-day exception).

Item Displays the name of the Calendar item (for
example, Team Meeting or Shift_1).

Site Date Displays the date of the Calendar item in the Site
Time Zone.

Start

Displays the time the Calendar item begins. Some
full-day rotating pattern items (Day Off, Any Shift,
and Flexible Shift) do not have start or end times.
For this reason, the Start time and End time
columns are empty for these items.

End

Displays the time the Calendar item ends. +1
indicates the day after the start time; +2 indicates
two days after the start time. Some full-day
rotating pattern items (Day Off, Any Shift, and
Flexible Shift) do not have start or end times. For
this reason, the Start time and End time columns
are empty for these items.

Status requested

Displays the status of a Calendar item for a period
that has not yet been included in a schedule, as set
by the user: Granted, Declined, or Preferred.

See Change Preference Status for an explanation of
the statuses. See Requested Status vs. Actual
Status for an explanation of the status that appears
in the status requested and Status actual columns.

Status actual Displays the status of the Calendar item as
resolved by Workforce Manager: Granted,

Getting started Calendar Items

Workforce Management Supervisor Help 29



Name Description
Declined, Preferred, Scheduled, or Not
Scheduled.

See Change Preference Status for an explanation of
the statuses. See Requested Status vs. Actual
Status for an explanation of the status that appears
in the status requested and Status actual columns.

Reason
Explains why WFM has set an item's actual status
to Declined. You can display/hide this column by
using the Option menu.

Comments/Memo

Displays any comments or additional information
associated with the Calendar item, including ones
that might have been entered by agents when
requesting the item using WFM Web for Agents. You
can display/hide this column by using the Option
menu. This column is not sortable.

Paid Hours
Displays the number of paid hours for the calendar
item. You can display or hide this column by using
the Option menu.

Hire Date Displays the date that the Agent began work for
the company.

Submitted
Displays the date and time that the Calendar item
was submitted (by either an Agent or a Supervisor,
depending on the type of Calendar item).

Site Time Zone Displays the Site Time Zone.

How to Use the Calendar

• Select any single date by clicking it.
• Select multiple dates by holding down Ctrl while clicking them.
• Select a range of dates by holding down Shift while clicking them or by clicking the first day and then

dragging the mouse to the last day before releasing the mouse button.
• Select the same day of the week throughout a month by clicking that day's header. For example, to

display all Mondays, click Mon.
• Display a different year or month by clicking the year or month drop-down arrow.
• Go back a month by clicking <, or advance to the next month by clicking >.

To retrieve specific data:

1. Select a date or range of dates.
2. Select one or more sites, one or more teams, or one or more agents (within one Business Unit) from the

Objects pane.
3. Click Get data.
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The table displays Calendar items for the selected site, teams, or agents. You can sort the display by
clicking the header for any column.

You can search the table for particular agents by using the Search button. To search for agents, select
the table to search and then enter the agent name, and press Enter. If the full text is too long to
appear in a calendar cell, hover your mouse pointer over that cell. The full text appears in a tooltip.

Important
By default, if another user adds a new exception type while you have the Calendar open, the new exception
type is not selected in the Filter dialog box. To see agents who have an exception of the new type assigned,
open the Filter dialog box and select the check box for the new exception type.

Calendar Object Hierarchy

When you enter more than one kind of Calendar item for an agent at the same time, a hierarchy
determines which takes precedence. The higher priority item appears as Granted, and incompatible
lower-priority items appear as Declined.

The order of priority for exceptions and preferences is:

1. Granted full-day exceptions.
2. Granted days off.
3. Granted full-day time off.
4. Granted availability.
5. Granted shifts.
6. Granted paid (working) hours.
7. Granted part-day exceptions, granted part-day time off.
8. Rotating patterns.
9. Preferred items (including exceptions, paid hours, and time off with preferred status).

Consistency Checks
After you add an exception or preference in the Calendar, the Calendar performs consistency checks
to determine whether it is valid.

To be valid, an exception or preference must:

• Fall within the agent's Contract availability hours.
• Fall within activity hours of operation for activities that the agent can perform.
• Be consistent with the Contract paid hours requirements. Unpaid exceptions are added to the paid

hours if they do not violate the Contract availability hours.
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In addition, if you are entering multiple part-day exceptions, part-day time off, or a mix of part-day
exceptions and time off, these:

• Cannot overlap.
• Must be compatible with a qualifying shift's settings, including meal parameters. (This limitation does

not apply to full-day time off or days off.)

Preference and Exception Considerations

• You can enter multiple compliant Calendar items for the same day. For example, you can enter a shift
and a day off for the same day. Or you can enter an availability and a shift for the same day if the shift
fits into the availability parameter. WFM Web assigns the item that best fits the agent’s schedule.

• You can enter only one full-day exception of a single type per day. However, you can enter multiple part-
day exceptions of the same type. (WFM Web sets the status of incompatible Calendar items to
Declined.)

• You can add or edit preferences and exceptions even after a schedule has been created for the affected
days. However, if you make changes after building the schedule, you must rebuild the schedule to pick
up the changes.

Explanation of Calendar Colors

The Calendar uses two basic cell colors, light blue and grey, and two colors for selected items, yellow
and white.

• Light blue indicates a selected cell for which data has not been requested. There may be data for that
day or there may not.

• Grey indicates a selected cell for which data was requested previously and it was selected again. That
is, at some point earlier in this session, you selected this date and clicked Get data.

• Yellow indicates a selected cell for which data was requested previously.
• White indicates a non-selected cell for which data has not been requested. There may be data for that

day or there may not.

The calendar uses two text colors, black and red.

• Black indicates that you have not yet requested data for a day, and that cells are not selected.
• Red replaces black when a cell is selected.
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Filter Dialog
Use the Filter dialog box to change which items appear in the Calendar Items module:

1. Select the Calendar tab.
2. Select Calendar Items from the Views menu.
3. Select one or more objects from the Objects pane. An object can be:

• In the Agents tree: a business unit, site, team, or agent
• in the Activities tree: business unit, a multi-site activity, site, activity.

4. Select a date or dates on the Calendar.
5. Click Get data.
6. Click the Filter icon on the Calendar Items module toolbar or select Filter from the Actions menu.

The Filter dialog box appears. It has three tabs:
• Calendar Items lists all exception types, preference types, time-off types, and rotating patterns.
• Status Requested lists all statuses that can appear in the Status Requested column of the

Calendar table.
• Status Actual lists all statuses that can appear in the Status Actual column of the Calendar table.

7. Clear the check boxes for any Calendar items or statuses that you want to hide from the Calendar
display. Or select the check boxes for any currently hidden items that you want to display.

8. Click OK to save your changes or Cancel to restore the existing selections.
The Calendar view is updated to match your selection.

Tip
By default, if another user adds a new exception type while you have Calendar open,
the new exception type is cleared in the Calendar Filter dialog box. To see agents
who have an exception of the new type assigned, open the Filter dialog box and
select the check box for the new exception type.
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Option Menu
Use the Option menu to show or hide columns in the Calendar items table.

• Site—The site of the Agent who appears in that row.
• Team—The team of the Agent who appears in that row.
• Shared Transport—The shared transport to which the agent (displayed in that row) is joined.
• Reason—An explanation for why the actual status is different from the requested status.
• Comments/Memo—Any comments or memo made when this calendar item was entered or most

recently edited.
• Paid Hours—The number of paid hours for the calendar item.
• Hire Date—The date that the Agent began work for the company.
• Submitted—The date and time that the Calendar item was submitted (by either an Agent or a

Supervisor, depending on the type of Calendar item).
• Site Time Zone—The time zone of the site.

To use the Calendar's Option menu:

1. Select the Calendar tab.
2. Select Calendar Items from the Views menu.
3. Select an object from each pane (Agents/Activities) of the Objects pane.
4. Select a date or dates on the Calendar, and click Get data.
5. Click the Option menu on the right side of the toolbar.

The Option menu opens and lists all available choices.
6. To display a column, select the check box next to its name. To hide it, clear the check box.
7. Click OK to save your settings or Cancel to discard them.

The main Calendar window re-appears, showing the new settings.
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Change Preference Status
Use the Calendar Items module to change the status of an agent's preference, exception, time off, or
working hours (shift and availability) request prior to publishing the schedule.

• Before you publish the schedule, the possible actual status settings are Preferred, Granted, and
Declined.

• After you publish the schedule, the possible actual status settings are Scheduled or Not Scheduled.

Preference Statuses

Before scheduling, a preference can be Granted, Declined, or Preferred. After a schedule is built
for the dates that include this preference, the status can be Scheduled (appears in the schedule) or
Not Scheduled (does not appear in the schedule).

• A Granted preference will appear in the schedule unless it is first removed or unless another
preference is added that out-ranks the first one. If this happens, the status of the lower-ranking
preference changes to Declined.

• A Declined preference will not appear in the schedule unless it was declined in favor of a higher-
ranking preference and the higher-ranking preference is later removed before the schedule is built. If
this happens the preference goes back to its original status, which can be Granted or Preferred.

• A Preferred preference may appear in the schedule if it complies with the scheduling constraints and
optimization settings that are configured for your site.

Two columns in the Calendar Items module show the preference status: Status Requested and
Status Actual. See below for an explanation of the two categories.

To change the status of a not-yet-scheduled item:

1. In the Calendar's item column, click the name of the item you want to change.
2. Click an action button for the item's new status: Prefer, Grant, or Decline.
3. Click OK.

The new status appears in the Status columns.

Important
The status can be different in each column, and the Actual Status can differ from the
status that you just assigned. This is because of the way in which the Requested and
Actual Status columns function, as explained below.
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Requested Status vs. Actual Status

Requested Status and Actual Status refer to the two ways in which each exception and preference is
saved.

• Requested Status is the preference's status as entered by the user. If more than one preference is
entered on a particular day, each item is saved to the database with the status that it has when
entered.

• Actual Status is the status as resolved by WFM. WFM evaluates all current exceptions and preferences
based on their positions in the calendar object hierarchy. If an agent has multiple preferences for a day,
the Actual Status indicates how WFM has resolved them.

For example, if an agent prefers a full-day time off, that preference is saved in the database as
Preferred. If the agent is then assigned (Granted) a meeting exception for that day, the exception
overrides the preference. WFM evaluates the current set of exceptions and preferences, and notes
the time-off preference as Declined. However, the database maintains the preference status as
Preferred because, until a schedule is generated, the exception can be removed. In this case the
preference would again take effect and the preference Actual Status would change to Preferred.

Tip
Rotating pattern assignments are Granted by default, so they do not need a separate
status saved to the database.
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Forecasts

Tip
This page describes the new Workforce Management (WFM) Forecast module interface
(introduced in 8.5.2). If you are using the classic Supervisors interface and have
landed on this page by accident, see the Workforce Management Web for Supervisors
Help (Classic), which describes the classic Forecast module.

In WFM, a forecast is a prediction of activity workloads for one or more sites, and consists of:

• Predicted customer-interaction volumes, which include information for phone calls, chat, email,
outbound calling, back-office work, and so on.

• Predicted average handling time (AHT).
• Staffing (workforce) requirements based on service objectives.

WFM uses these predictions to build optimal schedules for real agents, or for a generic staff of
profiles based on those agents. For links to important forecast help topics, see Working with
forecasts.
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Navigating the Forecast views

The Forecast module includes the following views:

• Scenarios—Click to open this view and display a list of existing scenarios. Open a scenario to see the
following views with data displayed in graph and table formats:
• Volumes—Click to open the Scenario Volumes view.
• Staffing—Click to open the Scenario Staffing view.
• Shrinkage—Click to open the Scenario Shrinkage view.

• Master Forecast—If you have access rights, open the following views to see data displayed in graph and
table formats:
• Volumes—Click to open the Master Forecast Volumes view.
• Staffing—Click to open the Master Forecast Staffing view.
• Shrinkage—Click to open the Master Forecast Shrinkage view.

• Overlays—Click to open this view and display a list of existing overlays.
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• Templates—Click to open this view and display a list of existing templates.

If you have open scenarios and you click Forecast > Scenarios to navigate back to the list view,
you can click Forecast again and see open scenarios at the bottom of the drop-down list. Click the
scenario name to display a sub menu containing the 3 scenario views: Volumes, Staffing, and
Shrinkage. Click any view in the sub menu to open it.

Tip
If you do not have access permission for the new Forecast module or other views
within the module, you will see the message Page Not Found. You don't have
permission to view this page when trying to access it. If required, ask your
Administrator to grant you access permission.

Reviewing terminology
To better understand WFM forecasting and scheduling views and dialog boxes, it is helpful to review
certain WFM terminology. Click these terms to open the definition in the glossary: Activity, Multi-Site
Activity, Site, and Business Unit.

For more information about these objects, see the Workforce Management Web for Supervisors Help
(Classic).

Working with forecasts

Here's an overview of the tasks involved in creating and publishing forecasts:

1. The first step in creating a new forecast is to create a forecast scenario for one or more activities using
the New Scenario wizard. The wizard dialog enables you to create scenarios with no forecast numbers
(to be supplied later).

2. If you created a scenario with no forecast numbers, open the Scenario Volumes view and use the Build
Volumes wizard to build interaction volume and AHT forecasts for each activity. You can use various
methods to build volume, including entering values, using historical data or templates.

3. Next, open the Scenario Staffing view and build a staffing forecast for each activity.
4. After you create and evaluate your scenarios, publish the best scenario to the Workforce Management

database. This scenario then becomes the Master Forecast. WFM Web builds schedules based on the
data in the Master Forecast.

How do you choose the best scenario? The best scenario is the one that comes closest to predicting
volumes, AHT, and staffing requirements for a given time-period, based on your contact center’s
service level objectives.
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Using historical data in forecasts

In most cases, forecasts are based on historical data.

• If historical data for interaction volumes and average handling time (AHT) has been imported, you can
create both interaction-volume forecasts and AHT forecasts simultaneously.

• If historical data exists for interaction volume but not for AHT, first create the interaction-volume
forecast using any of the forecasting methods. Then create the AHT forecast using a template.

• If historical data exists for AHT but not for interaction volume, first create the interaction-volume
forecast using templates. Then create the AHT forecast using any of the forecasting methods.
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Scenarios

Tip
This page describes Scenarios in the new Workforce Management (WFM) Forecast
interface (introduced in 8.5.2). If you are using the classic Supervisors interface and
have landed on this page by accident, see the Workforce Management Web for
Supervisors Help (Classic), which describes the classic Forecast module, including
scenarios.

In WFM, a forecast scenario is a prediction of activity workloads for one or more sites. You might
create many scenarios before defining the optimal one that will be used as the Master Forecast.

Open this view by selecting Forecast > Scenarios in the navigation bar. In the Scenarios view you
can:

• View a list of forecast scenarios, including the owner's name, start and end dates, comments, and
shared status.

• Filter the list of scenarios.
• Use the Actions menu and toolbar to complete other tasks.

Working in the Scenarios view
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The Scenarios view displays scenarios in a table format that you can filter by selecting:

• All—Displays all scenarios.
• My Scenarios—Displays only the scenarios you have created. This view opens by default when you

select the Scenarios view.
• Shared Scenarios—Displays only the shared scenarios created by other users.
• Other Scenarios—Displays only the unshared scenarios created by other users .This folder is only

accessible to users that have the appropriate privileges.

If there are no scenarios in any one of these views, you'll see this message in the middle of the
scenarios pane: There are no forecast scenarios to display. If there are no scenarios in the My
Scenarios view, you'll see this message: You do not have any forecast scenarios together with the
New scenario button. Click this button to create a scenario, if desired.

Restrictions: Viewing and deleting forecast scenarios
Some restrictions apply when viewing or deleting forecast scenarios:

• Users must have access to at least one activity or multi-site activity in the forecast scenario to see it.
• Users must have access to all activities and multi-site activities in the forecast scenario to delete it.

Contact center administrators determine the level of access to multi-site activities in Forecast
Scenarios, as described above. If you cannot access activities or multi-site activities in scenarios,
contact your administrator for assistance. They can find information in the Workforce Management
Configuration Options Reference.

Finding scenarios quickly
To quickly find a scenario in the table, click the up/down arrow in the Name column to toggle the list
in ascending or descending order, or enter the name into the Search field.
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Choose the columns you want to display in the table by clicking Actions . The Show columns
drop-down list opens containing the following columns: Owner, Start date, End date, Modified,
Comments, and Share status.

By default, all of the columns are preselected, except Modified. Deselect columns to hide them;
select columns to display them. If no columns are selected, only the Name column is displayed in the
table.

To sort the scenarios in ascending and descending order, click the arrow in the Name (see graphic),
Owner, Start date, Modified, or Share status column header.
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Using the Actions menu and toolbar

Use the toolbar buttons and the settings in the Actions menu to:

• Create scenarios.
• Open, close, and delete scenarios in the list.
• View the scenarios' properties and add comments.
• Create scenarios, based on existing scenarios.
• Publish scenarios to Master Forecasts.
• Extract data from Master Forecasts to put into scenarios.

Creating scenarios

Use the New Scenario wizard to create a new forecast scenario. Defining a forecast scenario
involves naming the forecast scenario, defining a date range, adding comments (optional), and
selecting the activities the forecast will cover. You can also create the scenario based on an existing
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forecast or build the scenario numbers later.
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To create scenarios:

1. In the toolbar, click New scenario.
The New Scenario wizard dialog opens at step 1 of 2.

2. Enter the Forecast name (limited to 127 characters).
3. Enter the Start date, and End date.

You can enter start and end dates or click the Calendar icon within these fields to select the
date from the calendar. The scenario's date range can be up to ten years.

4. If you want others to be able to see this scenario, select Shared.
5. In the text box, enter any helpful or relevant information about this scenario.
6. Click Next.
7. In the Select activities dialog, select one or more activities or multi-site activities.

You can also add activities to the forecast after it has been created.
8. Click Create.
9. When the success dialog opens, click OK.

Click Cancel at any time to cancel the action and close the wizard. To delete a scenario, see Deleting
scenarios.

Next steps:

• Build interaction volume and/or AHT into the scenario. For details, see Building volumes data.
• Build staffing into the scenario. For details, see Building staffing data.
• Publish the scenario to the Master Forecast. For details, see Publishing the forecast scenario.
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Opening and closing scenarios

To open a scenario in the Scenarios view:

1. Select the check box for the scenario and click Open in the toolbar, or click Actions and
select Open in the drop-down menu that appears.
The following views appear in the drop-down menu beside the scenario name (top-left
corner)

Volumes, and Staffing.

2. Click one of these views to open it.

Open scenarios appear in bold in the Scenarios view. Also, the Forecast menu retains a list of the 10
most recently opened scenarios, making it convenient for you to switch between them.
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To close a scenario, select the check box for the scenario and click Close in the toolbar, or click
Actions and select Close in the drop-down menu that appears.

To edit the scenario properties, see Viewing and editing scenario properties.

Creating scenarios based on existing forecasts

Basing a new scenario on an existing forecast is a convenient way to build forecasts with frequently
used settings. The wizard takes the dates and activities from the source scenario, and applies them
to the new scenario, but you can change these settings, if you wish.
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To create a scenario, based on an existing scenario:

1. In the row of the existing scenario, click the Actions drop-down menu and select Create based on....
The Created Based On dialog opens with the Based on check box selected.

2. If you want to retain the properties of the Based on scenario, check the Copy data check box.
3. Otherwise, set the properties for this scenario, by following steps 2 - 6 in procedure Creating scenarios.
4. Click Create.

The start and end dates, and the activities from the source scenario are selected in the Create
Based On wizard, by default.

To customize the forecast scenario, change the dates, select additional activities, or clear the
selected ones. You can also add activities to a scenario after its been created.
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Click Cancel or X at any time to cancel all actions and close the dialog.

Viewing and editing scenario properties

To view the scenario properties:
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1. In the Scenarios view, find the scenario you want to view and click the Actions menu.
2. In the drop-down list, select Properties.

The scenario properties dialog opens to the Data tab, by default.
3. Click Statuses to view the information in that tab.
4. To close the Properties dialog, click X in the upper-right corner or Cancel.

To edit the scenario properties:

1. In the Scenarios view, find the scenario you want to edit and click the Actions menu.
2. In the drop-down list, select Properties.

The scenario properties dialog opens to the Data tab, by default.
3. Edit the scenario name, shared status, and/or comments.
4. Click Save if you have made changes in the Data tab, or Cancel if you want to discard all changes.

You cannot change any of the information in the Statuses tab. The fields, controls, and columns in
both tabs are described below.

Scenario properties—Data tab
In the Scenario Properties dialog, click Data to display the information that pertains to this
scenario. The Name, Shared, and Comments fields are editable. You cannot edit the name of the
person who created the scenario, or the date the scenario was created or last modified.

Click Save if you make changes to the scenario's name, shared check box, and/or comments. Click
Cancel if you want to discard any changes you make.

Scenario properties—Statuses tab
In the Scenario Properties dialog, click Statuses to display the status of the activities, or multi-site
activity in the scenario and their associated business unit or site. A check mark in the Volumes,
AHT, Calculated staffing, or Required staffing column indicates that this statistic was built for
this activity.

Deleting scenarios

If you are unable to view or delete scenarios, you might not have the proper access priviliges. See
Restrictions: Viewing and deleting forecast scenarios.
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To delete a scenario:

1. In the Scenarios view, select the scenario you want to delete.

2. Click Delete in the toolbar or select Delete in the Actions drop-down menu.
3. When the confirmation dialog opens, select Delete to proceed or Cancel to cancel the action.

To delete multiple scenarios at once:

1. Select all of the scenarios you want to delete (using the check box beside each scenario).
2. Complete steps 2 and 3 in the procedure above.

To delete all scenarios in the table:
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1. Select the top-most check box in the column header (near the Name column header).
2. Complete steps 2 and 3 in the procedure above.

If you are deleting a single scenario, the confirmation dialog contains the scenario name. If you are
deleting multiple scenarios, the confirmation dialog states the number of scenarios being deleted.

Publishing and extracting forecast data

Use the Publish or Extract wizard to transfer or publish the forecast scenarios data to Workforce
Management database's Master Forecast, or to extract the data in the Master Forecast to forecast
scenarios.

Important
You must have the Publish role privilege to publish IV, AHT, and/or Staffing data to
the Master Forecast. See Forecast Role Privileges

Why publish forecasts?

Publishing a forecast means that the forecast is final. Schedules for a particular date range are based
on the published (Master) forecast for those dates. Until a forecast is published, you cannot calculate
certain performance data.
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Publishing the forecast scenario

To publish a forecast scenario to the master forecast:

1. In the Forecast Scenarios view, click Actions next to the scenario that you want to publish, and
select Publish.
The Publish or Extract dialog opens.

2. Click Publish to master forecast.
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3. Select or enter a start and end date for the Date range.
4. Select or enter a start and end date for the Publish to date range.
5. Select one or more check boxes: IV, AHT, Staffing.

These check boxes are not visible if you do not have the proper WFM role privileges.
6. Expand the business units and sites to select the activities you want to publish.
7. Click Publish.
8. When publishing is complete, click OK.

Alternatively, click Cancel at any time to discard the settings and close the dialog.

The tree shows all activities for which the selected scenario contains data, enabling you to select
multiple activities from different sites.

Tip
You can also publish forecast scenarios using the Save drop-down menu in the
Scenario > Volumes, Staffing, and Shrinkage views if you have modified the
scenario data after it's been published. For example, see Editing daily totals in the
grid

Defining start and end dates when publishing data

When publishing data, the start and end date values in the Date range section define the date
range for which you want to publish information from the selected scenario. By default, the selected
scenario's own start and end dates appear in these text boxes, and you cannot select dates outside
the original scenario dates.

The start and end date values in the Publish to date range section define the date range for which
you want to update information in the Master Forecast. By default, these fields' entries match those
in the Date range section. Data from a specific weekday is copied only to the same weekday. That
is, forecast information for a Monday is copied to one or more Mondays, depending on the target date
range that you select. Monday's data is not copied to every other day within the target date range.

The start date in each date range in the Publish or Extract dialog occur on the same day of the
week. The dialog shows the number of days in each date range below the End date field.

Viewing Review messages

If you have entered invalid data when completing the Publish or Extract wizard, after clicking
Finish the Review Messages dialog opens containing a list of errors:

• Click Back to return to the Publish or Extract dialog and make the necessary changes.
• Click Cancel to close the wizard and discard the previous settings. The scenario will not be published.

If you enter invalid values in the wizard, validation messages will appear below the respective fields,
prompting you to enter valid values.
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Extracting the Master Forecast data

To transfer data from the Master Forecast into a forecast scenario:
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1. In the Forecast Scenarios view, click Actions next to the scenario for which you want to extract
data, and select Publish.
The Publish or Extract dialog opens.

2. Click Extract from master forecast.
3. Select or enter a start and end date for the Date range.
4. Select or enter a start and end date for the Extract to date range.
5. Expand the business units and sites to select the activities you want to extract to the target scenario.
6. Click Extract.
7. When extraction is complete, click OK.

Alternatively, click Cancel at any time to discard the settings and close the dialog.

The tree shows only those activities that are included in the forecast scenario. Expand business units
and sites to display activities.

Defining start and end dates when extracting data

When extracting data, the start and end date values in the Date range section define the date range
for which you want to extract information from the Master Forecast. By default, these values match
those in the Extract to date range section.

The start and end date values in the Extract to date range section define the date range for which
you want to update the information in the selected target scenario. By default, the scenario's own
start and end dates appear in the text boxes, and you cannot select dates outside the scenario's
original date range.
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Volumes in scenarios
In Workforce Management (WFM), you'll use the Scenarios Volumes view to build or edit the selected
forecast scenario's interaction volumes and average handle times. This view provides a graph and
grid that shows statistics for a specified time period and standard date-selectors.

Viewing the volumes data

Scenarios open to the Volumes view where you can view, build, or edit the volumes data. When you
select an object in this view, the start date is determined by the selected business unit's week start
day setting, regardless of your locale settings. Watch the video.

To open the Volumes view:

1. In the Forecast module, select Scenarios.2.
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Select a scenario from the list in the data pane, and click Open in the toolbar or in the Actions
drop-down menu.
The Volumes view opens with the scenario name in the top-left corner of the window.

3. In the Objects tree, select an activity, multi-site activity, site, or business unit.
The view displays a graph above a table, each containing the same statistics and controls
that set the data display properties.

If you have not selected an activity, you'll see the message Select an activity within the nested tree
to load volumes.

Link to video
If you do not see any forecast data, you might have to adjust the Period drop-down list, the sliders
(below the graph), or the Granularity and Date controls at the top of the window to reflect those used
for the forecast.

The grid displays open hours for selected site activities and multi-site activities in the same way.

You can also view, add, and edit the staffing or shrinkage data in opened scenarios, by selecting
Staffing or Shrinkage from the drop-down menu near the scenario name.

Setting the data display properties

In this view, the graph's y-axis represents the values for selected statistic (IV or AHT); the x-axis
represents the selected period (week, month, or year). Use the following controls to customize the
data display in the graph and table:

Forecasts Scenarios

Workforce Management Supervisor Help 60

https://player.vimeo.com/video/431923234?title=0&byline=0&portrait=0


• Primary statistic drop-down list—Select the statistic that will be displayed as primary, by selecting
Interaction Volumes (IV) or AHT (average handle time). The primary statistic displays as a bar in the
graph and the secondary statistic displays as a line.

• Period drop-down list—Change the time range for the graph and grid by selecting Year, Month, or
Week.

• Granularity drop-down list—Adjust the granularity to Day if you selected Month or Year in the
Period drop-down list. Adjust each row's time range by selecting 15, 30, or 60 (minutes) from this list
if you selected Week in the Period drop-down list.

• Compare with previous years check box—Check to compare the IV or AHT data to the historical IV or
AHT data, based on the primary statistic. When checked, WFM displays more check boxes below the
smooth graph, enabling you to compare IV or AHT data to data from 1 - 5 years ago. See more about
historical data here.
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• Date range—Use the date-selectors (top-right portion of the view) to switch to a different period within
the scenario forecast's date range. The week number is also displayed here when the selected period is
Week.

• Actions drop-down menu—Click this icon to change the graph and/or table:
• Graph options—Show/hide the graph and zoom bar by selecting/clearing the Show graph check

box. See also Sliders.
• Show columns—Show/hide data columns in the table by selecting/clearing the following check

boxes:
• IV forecast #
• IV forecast %
• IV actuals #
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• AHT forecast #
• AHT actuals #

Click anywhere in the view to close the drop-down menu.
• Statistics/Applied events check boxes—Below the graph, toggle a statistic or applied events on or

off. Selecting the check box or clicking the radio button toggles it on, displaying the primary statistic as
bars, the secondary statistic as a red line, and applied events as a striped orange line. Clearing the
check box or clicking the radio button toggles it off, making the statistic or event invisible in the graph.
When turned on, the primary statistic's radio button is light blue and the Applied events button is
yellow.

For single-day events, the striped orange line covers the start of the day to the end of the day—Even
when you zoom in the graph. For multi-day events, the striped orange line covers the event start
date to the event end date. Hovering over the event in the graph opens a tooltip which shows the
event name and date.

Event types, including Applied events, are defined in Understanding event types.

Using the graph, zoom bar, and sliders
Watch the video to see a demonstration of the features in the Volumes views, shown in the graphics
above and described here:

Link to video

• Smooth graph button and icon—Edit the bar graph (using the button or icon) when an
activity is selected in the Objects pane and this feature is toggled on.
The bars representing the primary statistic come to the front of the graph and become bold,
the line representing the secondary graph fade to the background, and the x-axis zoom is
disabled.
Clicking any bar in the graph reveals a handle, enabling you to drag the bar up or down. The
corresponding cell in the grid is highlighted and the value increases or decreases as you
move the bar graph up and down. Similarly, if you click any cell in the grid and change the
value, the corresponding bar graph changes accordingly.
Dragging the bar to the upper limit of the y-axis increases the y-axis scale, causing the
remaining bars to scale down proportionally. If the bars are too narrow to select easily,
toggle off the smooth graph and switch your view to another time period or use the Zoom
bar.

• Sliders—Drag the vertical slider left/right to show/hide the graph, zoom bar, grid and/or Objects pane.
Click the arrows in the vertical slider to resize the Objects pane. Drag the horizontal slider up/down to
show/hide the graph and/or grid.

• Zoom bar—Use the zoom bar handles to narrow or widen the focus in the graph, by sliding the handle
left or right. You can zoom to a minimum of one day. After narrowing the focus, place your cursor over
the graph and change the range of the zoom by dragging and dropping it to the left or right. For
example, if you narrow the focus to Sunday, Monday, and Tuesday, but want to change it, drag and
drop the zoom to the right to Tuesday, Wednesday, Thursday.
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Reading the Data

The grid (below the graph) provides columns that display the following statistics:

• Daily total—If you select the period Week, this row shows daily totals for IV and AHT.
• Weekly total—If you select the period Month or Year, these columns show the weekly totals for IV

and AHT.
• Date/Time step—Identifies the range of dates or timesteps in this row. The column name and contents

will differ, depending on the period and granularity you selected above.
• [Days or Dates]—If you select the:

• Week date range—Each group of columns indicates one day, the top row shows daily totals, and
each lower row shows statistics for one timestep on that date.

• Month date range—Each group of columns shows statistics for one full day.
• Year date range—Each group of columns shows statistics for one full day.

Timestep duration depend on the granularity that you selected above.
• Interaction Volumes—Shows the interaction volume forecasted for each day or timestep. You can edit

the cells' contents, replacing the displayed values with integer values.
• Average Handle Time—Shows the average handling time forecasted for each day or timestep. You

can edit the cells' contents, replacing the displayed values with integer values (with two decimal
points).

• Compare with IV actuals—Compares actual IV data with historical IV data that was imported or
collected. When comparing data to previous years, WFM displays the same weekdays as the actual,
irregardless of the selected period (Week, Month Year). For example, if the specified date range is
Thursday, Nov 1st 2018 to Friday, Nov 30th 2018:
• If 1 year ago is selected, the actual IV is compare to the historical date range Thursday, Nov 2nd

2017 to Friday, Dec 1st 2017.
• If 3 years ago is selected, actual IV is compare to the historical date range Thursday, Oct 29th

2015 to Friday, Nov 27th 2015.

Tip
You can copy and paste data between the grid and a spreadsheet.

Editing data in the grid

In the Scenario > Volumes grid, WFM enables you to edit forecast and actual values. You can edit
timesteps and daily totals when the selected period is Week and edit weekly and daily totals when
the selected period is Month or Year.

When changing the period, granularity, and/or values in the grid, note that daily totals are

Forecasts Scenarios

Workforce Management Supervisor Help 64



aggregated values for a 24-hour period. This means the daily and weekly totals automatically adjust
and are redistributed according to the original distribution of volume for each day of the week or
week of the month/year. This is useful if you have a week in which you believe the volume will be
increased, but you expect the volume to arrive at about the same rate as in your original forecast,
day-over-day.

Tip
You must have the Forecast access privilege Edit Historical Data to edit Actual IV
and Actual AHT values in the grid.

Editing IV values
Here are some things to keep in mind when editing IV values in the grid. If you edit the IV Forecast %:

• Time step values—WFM recalculates IV Forecast # and IV Forecast % values for all time steps on days
that have IV values greater than 0.

• Daily total values—WFM recalculates IV Forecast # and IV Forecast % values for all time steps on days
that have IV values greater than 0. The IV Forecast # daily total is changed but the resulting IV
Forecast % daily total will be 100%.

• Weekly total values—WFM recalculates IV Forecast # and IV Forecast % values for all week days that
have IV values greater than 0. The IV Forecast # daily totals are changed but the resulting IV
Forecast % daily and weekly totals will be 100%.

IV Forecast % values cannot be greater than 100%. IV Forecast % daily and weekly total must be
100%.

Editing modes
WFM provides two editing modes in the Volumes grid. Single-clicking a cell puts it into quick-editing
mode and double-clicking a cell puts it into deep-editing mode. You can use either method for all
editing functions.

Navigating the grid
In the grid, you can move from cell to cell by using the Enter or Shift+Enter keys on the keyboard.
Click a cell and press:

• the Enter key to move the focus to the cell below the one selected.
• the Shift+Enter keys to move the focus to the cell above the one selected.

If you select a cell in the Daily total row, you can use Enter to move down one cell, but you cannot
use Shift+Enter to move up one cell.
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To edit values in the grid:

1. Click (or double-click) the cell you want to change and enter a value.
2. When you have finished, in the upper-right corner of the view, click Save (or use the hotkey combo

Alt+S).
A message appears in the lower-right corner, indicating your changes were saved
successfully.

If you switch to another view without saving the changes, a dialog opens with the message Would
you like to save changes to <scenario name>. Click:

• Save to save the changes and switch to another view.
• Discard to discard the changes and switch to another view.
• Cancel to cancel the action, close the dialog, and return to the Volumes view.

From the Save menu, you can also select:

• Publish (Alt+P) if you have modified the scenario data and want republish it.
• Save as template... to save this scenario as a template.
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• Close (Alt+W) to close the scenario.

Selecting data to copy and paste

Tip
If you are unable to copy/paste, ask your administrator to confirm that your
environment is using HTTPS secure connections to WFM. See the Workforce
Management Administrator's Guide.

Use Copy and Paste in the toolbar or use the Ctrl-C and Ctrl-V key combinations on your keyboard to
select data in the Volumes view grid for copying and pasting. You can copy/paste within the grid and
to/from documents, such as Excel or Notepad. You can also copy and paste data from Master
Forecasts and other scenarios.
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Copy and Paste are enabled in the toolbar when you select a single cell or a range of cells. When
selected, cells are highlighted and bordered with a bold solid line. When copied to the clipboard, they
are bordered with a dashed or broken line. Targeted or pasted cells are highlighted and bordered with
a bold solid line.

When you copy empty cells together with cells that contain values, they are pasted as empty cells,
overwriting any original values.

For some key combinations, you must select values in the Daily values row, Time step column, and
Date column (when the selected period is Month or Year) separately. They cannot be selected with
other rows or columns in the grid. Also, time step values and dates can be pasted only to external
sources (not into the grid). You cannot select, copy, or paste the Time step header row (Mon , Tue.
etc.).

The grid scrolls automatically when you select a range of cells using the Arrow, Home, End, Page Up,
or Page Down key, or the Shift+Arrow, Shift+Home, Shift+End, Shift+Page Up, or Shift+Page Down
keys. However, if you select more cells to copy than you select for paste, only a part of data is
pasted. See more information about these functions in Managing templates.

You cannot paste data if you have:

• Selected days that are outside of the scenario date range.
• Selected a business unit or site in the Objects pane. You must select an activity or multi-site activity.
• Selected values in the IV% column

Attempts to paste any of the following invalid values into the grid or Daily totals/Average row
results in the message: Cannot paste invalid values.

• Letters, special symbols, or negative values
• Non integer values for IV
• AHT decimal values that have more than 2 digits after the period
• Values that are out of range

Using the Scenario Volumes toolbar

Use the following buttons on the toolbar (above the graph) to modify and manage volumes data:

Icon Name Description

Copy Copies data selected in the grid
to the clipboard.
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Icon Name Description

Paste Pastes data from the clipboard to
the selected area in the grid.

Build
Opens the Build Volumes wizard,
enabling you to build volume
data for the selected activity.

Add activities

Opens the Add Activities
dialog, enabling you to add
activities and/or multi-site
activities to existing scenarios.
Find the procedure here.

Remove activities

Opens the Remove Activities
dialog, enabling you to remove
activities and/or multi-site
activities from existing scenarios.
Find the procedure here.

Adjust

Opens a Adjust Volumes dialog,
enabling you to adjust the
volume, average handling time
(AHT), or both for the Scenario
Forecast Volumes view.

Split
Opens the Split Volumes wizard,
enabling you to split interaction
volumes from a multi-site activity
to site-specific activities.
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Building volumes
In Workforce Management (WFM), you'll use the Build Volumes wizard to build volumes data in
forecast scenarios for one or more selected activities, using parameters that you specify.

Before using this wizard, think about the build method you want to use. Depending on your choice,
you might need to import historical data or create interaction volume, average handling time, or
templates before building volumes data.

Building volumes data

Use the Build Volumes wizard when you are creating new scenario volumes or if you want to
overwrite an existing scenario volumes. Do not use it if the correct volumes data already exists in the
Scenario Volumes view.
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To build volume data:

1. Select a scenario and click Open on the toolbar or in the Actions drop-down list.
The Scenario Volumes view opens.

2. In the Objects pane, expand the tree to select an activity or multi-site activity.
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3. On the toolbar, click Build .
The Build Volumes wizard opens.

4. Select the activities that will be associated with this scenario volume. See Step 1
5. Select the target date range and build method. See Step 2.

Step 1: Selecting activities for the scenario

The activities you previously selected for the scenario in the New Scenario wizard Select activity
screen appear for selection.

To select activities:

1. Expand business units (if any) to display their sites and multi-site activities, and expand sites to display
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their activities.
2. Select all of the activities that you want to be included in this volumes forecast, taking note of the

following:
• You can select multiple activities to build volume forecasts in batch mode when configuration

information for each activity is identical. If you want to use different historical data or build methods
for certain activities, build the volumes for those activities separately.

• You can add activities to a forecast after it has been created.

3. Click Next to continue.
In Step 2 of the wizard, you'll select a target date range and data build method (see next
procedure).

Step 2: Selecting target date range and data build method

In step 2 of the Build Volumes wizard, when you are selecting the build method, the dialogs that
open next depend on the method you select. See the graphics in Choosing a build method.
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To define how you want to build your volumes data:

1. Select the Start date and End date for this build.
2. Select the statistics: IV, AHT, or IV+AHT.
3. Select one of five build methods. If you select:

• Automated (default), complete this procedure.
• Template based, complete this procedure.
• Copy historical data, complete this procedure.
• Use values, complete this procedure.

4. When you have finished populating all dialogs, click Build.
5. When the build process is complete, click OK.

Tip
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Clicking Cancel during the build process closes the wizard but does not necessarily
prevent volumes from being built.

Next steps:

• Build staffing into the scenario. For details, see Building staffing data.
• Publish the scenario to the Master Forecast. For details, see Publishing the forecast scenario.

Choosing a build method

WFM provides different methods to build forecast data, enabling you to choose the one that is most
appropriate for your environment. They are described in this topic, along with procedures to help you
apply the appropriate settings for the method you choose.

Automated
This is the default build method and an appropriate selection if you want to use one of two WFM
automated algorithms: Expert Average Engine and Universal Modeling Engine.
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If you selected Automated (default) in Step 2 of the Build Volumes wizard:

1. Select either Expert average engine or Universal modeling engine.
2. For Historical date range, choose to:
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• Do nothing, and retain the default All available.

• Click Edit and select the date ranges.
If you click Edit, the Select Date Range dialog opens. If there is no historical data for the
specified activity, the dialog does not open and WFM displays a validation message.

3. Click Add date range to add one or more date ranges, modifying them as necessary and then, click
OK.
By default, WFM displays the start and end date of the historical date range for the selected
activities.

4. Click one of two radio buttons:
• If you choose Use all applicable events, WFM includes all events associated with the selected

activities for the specified statistic within the scenario date range/historical date range.
• If you choose Select events, click Edit.

The Select Events dialog opens.
• Click each event's check box if it should be considered for calculation and then, click OK.

Clicking the top-most check box selects all events in the list.

Read more about events in Using overlay events in forecasts.
5. Click OK.
6. When the wizard returns to Step 2, click Build.
7. When the build process is complete, click OK.

Expert Average Engine

This engine uses the statistical analysis of historical data to produce day-of-week, weekly, and (if
sufficient historical data exists) yearly trend patterns. It requires at least one full week of historical
data. For high-quality day-of-week and weekly results, Genesys recommends that you use a minimum
of six weeks of data.

Expert Average Engine applies events in a linear fashion, and this linear perspective smooths out the
impact of events across the forecast. Therefore, this selection is best suited to contact centers with
fairly stable interaction patterns.

Universal Modeling Engine

This engine uses a complex algorithm to identify trends and patterns in historical data, which it then
uses to create a forecast. It requires one year's worth, or more, of historical data. In its analysis of
historical data, this engine disregards days that contain special events if those events don’t occur
during the forecast period, thereby eliminating any misleading "noise" from the forecasts. However, if
a special event does occur during the forecast period, the Universal Modeling Engine uses the
historical data to calculate the impact of the event, and applies it to the baseline forecast.

This selection is best suited to sites with a large quantity of high-quality historical data.
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Template based
This is an appropriate selection if you want to build a forecast using preconfigured interaction volume
(IV) and/or average handling time (AHT) templates. You can also use template-based forecasting to
apply a percentage growth rate to historical data.
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If you selected Template based in Step 2 of the Build Volumes wizard:

1. Click Edit to select an IV template, AHT template, or one of each.
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2. In the Select Templates dialog, click Add template to add 1 or more templates
3. Click the down arrow in the Template name field to select a template from a list.
4. Click OK.
5. When the wizard returns to Step 2, click Build.
6. When the build process is complete, click OK.

It's best to use template-based forecasting in contact centers with very stable interaction patterns or
for activities that can be manually forecast, such as back-office work, media interactions, or outbound
campaigns.

For detailed information about templates, and instructions on how to create them, see Templates.

Copy historical data
This is an appropriate selection if you have some historical data, but not enough to use the Expert
Average or Universal Modeling engines. You can combine the historical data with templates, which fill
in gaps in the historical data.
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If you selected Copy historical data in Step 2 of the Build Volumes wizard:

1. Enter a Start date or select one by clicking the Calendar icon.
Read more about the start and end date in Using historical data in forecasts

2. Enter a percentage for Growth rate or select one by using the up/down arrows.
3. Click Build.

If you select this build method and a selected activity does not have historical data, you'll see the
following error message after clicking Build: There is no historical data for the parameters specified.

Use values
This is an appropriate selection if your site activity load is very regular. It applies a specific interaction
volume or AHT to each time interval in the scenario.

• Interaction Volume and AHT—Both the IV and AHT fields are enabled and entered values are used
for each cell in the forecast.
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• Interaction Volume—Only the IV field is enabled. The values entered represent the number of
interactions per timestep (for example, the number of interactions per 15-minute interval).

• AHT—Only the AHT field is enabled. The values entered represent the average handling time, in
seconds.

If you selected Use values in Step 2 of the Build Volumes wizard:

1. Enter a value for IV.
This value represents the number of interactions per timestep in the forecast. For example,
the number of interactions per 15-minute interval.

2. Enter a value for AHT
This value represents the average handling time, in seconds.
If you enter a value in both IV and AHT, these values are used for each timestep in the
forecast..

3. Click Build
4. When the build process is complete, click OK.
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Using historical data in forecasts

The Volumes view displays Interaction volumes (IV) within imported or collected historical data. See
the option to Compare with previous years in Setting the data display properties.

WFM enables you to define the historical data time range when building volumes. When setting the
start date, select the same day of the week as the forecast scenario's first day. For example, if the
target start date is a Tuesday, the historical data start date must also be a Tuesday.

The default date range is dependent on the the target date range and statistic you selected in the
wizard, and changes based on of these values. For example, There is one date range for AHT data
and one for IV data. If you select IV+AHT WFM combines the date ranges, using the earliest
historical data start date and latest historical data end date of the two.

When setting the end date, keeping the following information in mind:

• If you selected the Copy historical data build method, this field is disabled. The same historical start
and end dates are used for all activities selected for this forecast.

• Remember that redistributing events does not impact historical data, only the forecast.
• If you entered a value in the Growth rate field, the historical data is increased or decreased by that

specified percent. The value cannot be less than -99.99%.

If the build method is Automated using Expert Average Engine or Universal Modeling Engine, you
can add additional historical periods to the list, to specify the exact historical data that you wish to be
used (and ignore any data that you wish not to be used).

You can clear selected date ranges by clicking the x in Historical date range field. This action
clears previous selections, but retains the defaults. For all build methods, clicking Edit beside the
Historical date range field generates an error message if no historical data exists for the selected
activity/statistic.

Using overlay events in forecasts

You must create events and assign them to activities in the Forecast > Overlays view, before you
can add them to a forecast scenario

An overlay is anything that can be expected to affect the daily interaction volume of the enterprise
and, therefore, staff and schedule requirements. An event is a specific instance when an overlay is in
effect.

Adjust the Initial Impact and/or Ending Impact value, if appropriate. The default values are based
on the event's configuration. If the event is configured to disregard historical data, you cannot adjust
these values here. You must change the configuration using the Overlays module.

Click Distribution to view and optionally change the distribution of the selected overlay. WFM Web
calculates the volumes and displays them in the Volumes view. An error message appears if WFM
Web cannot complete the calculation (for example, if the historical data contains too few timesteps to
cover the scenario's activity hours).
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Redistributing events does not impact historical data, only the forecast.

You can clear selected events by clicking the x in Select events field. This action clears previous
selections, but retains the defaults. If the selected activity does not have overlay events, you'll see
the message You do not have any overlay events.
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Adjusting and splitting volumes
In Workforce Management (WFM), you'll open a forecast scenario and use the buttons in the
Volumes view toolbar to adjust and split volumes.

Adjusting volumes within a date range

Use the Adjust Volumes wizard to adjust interaction volumes, the average handling time (AHT), or
both in a Scenario Volumes view.
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To adjust the scenario's volume:

1. In the Volumes view toolbar, click Adjust Volumes .
2. In the open dialog, click the radio button for the primary statistic you want to adjust, either Adjust IV
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by or Adjust AHT by
3. Decide how (and by how much) to adjust the statistic in the grid:

• Select Percentage and enter a number by which to adjust existing values or use the up and down
arrows to select a number.
Valid values range from -99% to 999%.

• Select Value and enter a number (or select one using up/down arrows) that will be the total value
by which to adjust the existing values that fall within the date and time ranges set in steps 4 and 5
of this procedure.

4. To adjust values in the grid, specify the date range by entering a start and end date or by selecting
them from the calendar
The Start date range can be any date equal to or later than the date in the upper right of
the Volumes grid; 00-23 hours. The End date range can be any date later than the Start
date; 00-23 hours.

5. Specify the time step by entering or selecting values in the Start time and End time fields.
The start and end time must be in 15-minute increments. For example, 00, 15, 30, or 45
minutes.

6. Click Adjust.
7. When the confirmation dialog appears, click OK.

Note that you can click Cancel at anytime to cancel this action and close the Adjust Volumes
dialog.

Adjusting volumes within time steps

You can adjust interaction volumes, the average handling time (AHT), or both in a Scenario Volumes
view by changing the values directly, in time steps.
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To adjust the scenario's volume in time steps:

1. Open a scenario to the Volumes view.
2. In the Objects pane, select a activity or multi-site activity that has volumes data.
3. Select the Granularity (15, 30, 60) and the interval (Day, Month, Year) of data you want to see.
4. In the grid, double-click the cell for the time step you want to change (IV, AHT or both).
5. Enter the new values, as many as necessary.
6. Click Save.

The message Changes saved successfully appears in the bottom-right corner of the view.

If the changes were not saved, the message Failed to save changes appears. Try entering different
values.

Splitting Volumes

Use the Split Volumes wizard to split a forecast scenario's volume between the activities contained
within a multi-site activity. In the procedures below, click the links in a specific setting to find more
information about it.

To split a scenario's volume:
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1. In the Forecast > Scenarios view, select a scenario.

2. Click the scenario's Actions menu and select Open, or select the scenario's check box and click

Open in the toolbar.

3. In the Activities pane, select a site that contains multi-site activities, and click Split .
The Split Volumes wizard opens at Step 1.
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Step 1:

1. Enter a date range in the Start date and End date fields.
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2. Expand the activities tree and select the check box beside the multi-site activities you want to split.
You can select several multi-site activities within the same business unit.

3. To include the average handling time forecasts in the split, select Use AHT forecast and click Next.
If you selected multi-site activities of type Deferred, the wizard's Step 2 opens.
If you selected multi-site activities of any other type, the wizard skips Step 2 and opens at
Step 3.

Step 2:

1. For each deferred multi-site activity, select a Service time type in drop-down list:
• Business days
• Hours, non-interrupted time
• Hours, interrupted time.

2. Enter a value in the Service time field and click Next.
Step 3 of the wizard opens.
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Step 3:

1. Expand the activities tree to select activities within the multi-site activities.
2. Alternatively, select the Use all activities to include all activities in the specified site. See more below.
3. Select the Consider granted calendar items check box, if you want WFM to consider existing

Calendar items when splitting the interaction volume among activities.
4. Click Next.

Step 4 of the wizard opens.
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Step 4:

1. Optionally, enter a value for Split (%), or use the up/down arrows to select a percentage.

2. Or, in the Template column for each multi-site activity, select Edit .
A dialog containing a list of templates opens.

3. Choose a template and click OK.
The wizard returns to Step 4.

4. Click Split.
WFM splits the forecast's volume.

5. When the confirmation dialog opens, click OK.
6. After reviewing the messages, click OK to close the dialog.

Review the split volumes in the table or graph.

If you enter a split percentage and WFM cannot process the split as expected, the Splitting Results
dialog opens, displaying a list of error messages in table format with the following columns:
Business unit, Activity, Unsplit IV, and Message.

In any one of the steps in the Split Volumes wizard, click Cancel to quit the wizard and discard all
settings.

More about the Split Volumes settings
This topic provides detailed information about the settings in the Split Volumes wizard.

Use AHT forecast

If you select Use AHT forecast and you select activities that do not have an AHT forecast, the
resulting value for each of these activities will be 0 for the timestep(s) where AHT=0.

If you do not select Use AHT forecast, the multi-site activity AHT is assigned to the local activities
and the local activity AHT is overwritten. If there is no multi-site activity AHT, the local activity AHT is
deleted.

Service time type

A drop-down menu with the following values:

• Business days—The number of business days, including the current day during which the interaction
arrived. If the service level = 100% within one business day, then all interactions must be serviced on
the same day they have arrived, according to open hours.

• Hours, non-interrupted time—When an interaction is waiting, while the activity is closed, the time is
still being counted in the service level calculations.

• Hours, interrupted time (default selection)—When an interaction is waiting, while the activity is
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closed, the time is not being counted in the service level calculations.

Service time

The nature of this control depends upon the granularity of your selection in the Service time type
field.

• If you select hours, you must specify hours, minutes and seconds. The value must be greater than 0.
• If you select business days, you must specify an integer that is greater than 0.
• If you switch the granularity from hours to business days, WFM Web resets the time value to 0.

Select activities within multi-site activities

Select the local (target) activities into which you want to split the multi-site activities. You can select
several target activities, but note the following constraints:

• If you selected Use AHT forecast in Step 1 of the wizard, then you cannot select target activities that
do not have at least one time step with at least one AHT value greater than 0.

• If you select Use all activities in Step 3 of the wizard, when WFM splits data for interaction volumes,
AHT, and availability of agents for the selected activities in the scenario, it takes into account the
values for all activities in the specified business unit, whether selected or not.
Activities that are not selected are not split; WFM Web simply considers them when
determining the proportions that are split to each selected activity. This option does not
affect the split result if there are no shared multi-skill agents who work on both selected
and unselected activities.

Split % and templates

Splitting volumes and using templates are optional in Step 4. If you do not want to do either, simply
click Split in the dialog without changing the settings.

If you choose to, enter a split percentage for each of the activities within the multi-site activities, or
click in the Edit to select and use a template. If you use both a split percentage value and a template
for any activity:, WFM uses:

• The split percentage value for empty time steps
• The template values for all non empty time steps

You can specify a percentage to allocate the volumes from a multi-site activity to each child (site)
activity. An interval can be the entire forecast scenario that includes a week, day, and time step.

At the interval level, when a percentage is specified that is greater than the time step, WFM
propagates the percentage to the remaining time steps. If a percentage is not specified for certain
child activities, WFM splits the remaining volumes to those activities, splitting them by availability.
You can specify a different percentage value for each interval.
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Staffing in scenarios
In Workforce Management (WFM), you'll use the Scenario Staffing view to define or edit a forecast
scenario's calculated and required staffing. Staffing refers to the number of agents that are required
to meet a given set of requirements for a specific time range.

This view provides standard date-selectors and a grid that shows staffing levels for days or timesteps.

Viewing the staffing data

Open the Staffing view by using the scenario's drop-down menu (see below). (Scenarios open to the
Volumes view by default.)

To open the Staffing view:

1. In the Forecast module, select Scenarios.
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2. Select a scenario from the list in the data pane, and click Open in the toolbar or in the Actions
drop-down menu.
The Volumes view opens by default with the scenario name in the top-left corner of the
window.

3. Click the scenario's drop-down menu and select Staffing.
4. In the Objects tree, expand a business unit, then a site to select an activity, or multi-site activity.

The view displays a graph above a table or grid, each containing the same statistics, and
controls that set the data display properties for the graph and table.

Link to video
If you have not selected an activity, you'll see the message Select an activity within the nested tree
to load staffing. If you still do not see any data, you may need to adjust the Period, Granularity, or
date-selectors at the top of the window to reflect those used for the forecast.

The grid displays open hours for selected site activities and multi-site activities in a similar way.

You can also view, add, and edit the volumes or shrinkage data in opened scenarios, by selecting
Volumes or Shrinkage from the drop-down menu near the scenario name.

Setting the data display properties

In this view, the graph's y-axis represents the number of agents; the x-axis represents the selected
period (week, month, year). Use the following controls to customize the data display in the graph and
table:
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• Primary statistic drop-down list—Select the statistic that will be displayed as primary, by selecting
Calculated staffing or Required staffing. The primary statistic displays as a bar in the graph and
the secondary statistic displays as a red line.

• Period drop-down list—Change the period or time range for the graph and grid by selecting Year,
Month, or Week.

• Granularity drop-down list—Adjust the granularity to Day if you selected Month or Year in the
Period drop-down list. Adjust the granularity to 15, 30, or 60 (minutes) if you selected Week in the
Period drop-down list.

• Date range—Use the date-selectors (top-right portion of the view) to switch to a different period within
the scenario forecast's date range.
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• Actions drop-down menu—Click this icon to change the graph and/or grid:
• Graph options—Show/hide the graph and zoom bar by selecting/clearing the Show graph check

box. See also Sliders.
• Show columns—Show/hide data columns in the grid by selecting/clearing the Calculated

staffing, Required staffing or Secondary data check boxes.
• Secondary data—Hover over this item to open a fly-out menu that lists all of the secondary data

types that can be displayed in the graph and grid.
If Secondary data is checked in the Show columns section, the data type that you select
from the fly-out menu is the name of the column that displays in the grid and the check
box below the graph, and it displays as the y-axis statistic. To learn more, see Viewing
secondary data.

Click anywhere in the view to close the drop-down menu.
• Toggles—Below the graphic, toggle a statistic (Calculated, Required, Secondary data), or Applied

events on or off in the graph. Selecting the check box toggles it on, and clearing the check box toggles
it off. When checked, the radio button is:
• solid blue for Calculated.
• outlined in magenta for Required.
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• outline in a broken dark blue line for Secondary data.
• outlined in a broken yellow line for Applied events.

Using the graph, zoom bar, and sliders
Watch the video to see a demonstration of the features in the Staffing view, shown in the graphics
above and described here:

Link to video

• Smooth graph button and icon—Edit the bar graph (using the button or icon) when an
activity is selected in the Objects pane and this feature is toggled on.
The bars representing the primary statistic come to the front of the graph and become bold,
the line representing the secondary graph fade to the background, and the x-axis zoom is
disabled.
Clicking any bar in the graph reveals a handle, enabling you to drag the bar up or down. The
corresponding cell in the grid is highlighted and the value increases or decreases as you
move the bar graph up and down. Similarly, if you click any cell in the grid and change the
value, the corresponding bar graph changes accordingly.
Dragging the bar to the upper limit of the y-axis increases the y-axis scale, causing the
remaining bars to scale down proportionally. If the bars are too narrow to select easily,
switch your view to another time period or use the Zoom bar.

• Sliders—Drag the vertical slider left/right to show/hide the graph, zoom bar, grid and/or Objects pane.
Click the arrows in the vertical slider to resize the Objects pane. Drag the horizontal slider up/down to
show/hide the graph and/or grid.

• Zoom bar—Use the zoom bar handles to narrow or widen the focus in the graph, by sliding the handle
left or right. You can zoom to a minimum of one day. After narrowing the focus, place your cursor over
the graph and change the range of the zoom by dragging and dropping it to the left or right. For
example, if you narrow the focus to Sunday, Monday, and Tuesday, but want to change it, drag and
drop the zoom to the right to Tuesday, Wednesday, Thursday.

Reading the data

The table provides columns that display the following statistics:

• Daily total—If you select the period Week, this row shows daily totals for Calculated and Required
staffing.

• Weekly total—If you select the period Month, these columns show the weekly totals for Calculated
and Required staffing.

• Monthly total—If you select the period Year, these columns show the monthly totals for Calculated
and Required staffing.

Forecasts Scenarios

Workforce Management Supervisor Help 99

https://player.vimeo.com/video/300380433?title=0&byline=0&portrait=0


• Date/Time step—Identifies the range of dates or timesteps in this row. The column name and contents
will differ, depending on the period and granularity you selected above.

• [Days or Dates]—If you select the:
• Week date range—Each group of columns indicates one day.The top row shows daily totals

measured in full time equivalents (FTE). Each lower row shows statistics for one timestep on that
date.

• Month date range—Each group of columns shows staffing for one full day.
• Year date range—Each group of columns shows staffing for one full day.

Timestep durations depend on the granularity that you selected above.
• Calculated—Shows the calculated number of agents for each day measured in full time equivalents, or

for each timestep measured in single skill equivalents. You can edit the cells' contents, replacing the
displayed values with whole numbers.

• Required—Shows the required number of agents for each day measured in full time equivalents, or for
each timestep measured in single skill equivalents. You can edit the cells' contents, replacing the
displayed values with whole numbers.

WFM populates Calculated staffing when you build staffing, by using the Build Staffing wizard.
Required staffing is a user-defined data series that you build, by using the Required Staffing wizard. It
can be populated based on data from the calculated staffing data series, or you can copy and paste
data from an external spreadsheet into these columns. When building schedules, the Use Required
setting lets you base a schedule on calculated or required staffing. This allows you to take the
staffing forecast that WFM provides and adjust it in a user-defined way.

Tip
You can copy and paste data between the grid and a spreadsheet.

What are full-time equivalents?
Full Time Equivalents is a standard measurement used within contact centers that allows the analyst
to do an "apples-to-apples" comparison of the number of agents required to handle the expected
interaction volume, across activities that may have different open hours, different planned
overheads, and so on. WFM provides the number of FTEs for informational purposes only. It does not
affect the Intra-day staffing requirements that WFM produces, which is the basis for building
schedules.

Viewing secondary data

You can display and view secondary data in the Staffing graph and grid, in any granularity (Day,15,
30, 60 minutes) and for any period (Week, Month, Year).

To display the data in the graph:
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• Toggle on the secondary data check box below the graph.
The secondary data appears in the graph as a broken dark blue line.

To display the data in a separate column in the grid:

• Select the Secondary data check box in the Show columns section of the View options drop-down
menu.
The column header will have the name of the secondary data type you choose from the
Secondary data fly-out menu. This column is read-only (cannot be edited).

The list of statistics you see in the Secondary data fly-out menu depends on the object or activity
type you select in the Objects pane. Fixed-staff activities/multi-site activities (MSA) do not have
secondary data. If you select this activity type in the Objects pane, there is no Secondary data fly-
out menu nor does the column in the grid.

You can display secondary data for an object by selecting one of the following types in the fly-out
menu:

Secondary data type Description Displays in menu if selected
object is:

Service Level Objective
The requirement for the service
level, as defined when building
the forecast.

• business unit
• site
• immediate activity or MSA
• deferred activity or MSA

Service Level
The forecast service level, which
is calculated using Staffing
Calculated values.

• business unit
• site
• immediate activity or MSAService Level Required

The forecast service level, which
is calculated using Staffing
Required values.

Deferred Service Level
The forecast deferred service
level, which is calculated using
Staffing Calculated values.

• business unit
• site
• deferred activity or MSA

Deferred Service Level
Required

The forecast deferred service
level, which is calculated using
Staffing Required values.

Forecasted Calculated Queue
The forecast queue, which is
calculated using Staffing
Calculated values.

Forecasted Required Queue
The forecast queue, which is
calculated using Staffing
Required values.

Avg Speed of Answer
Objective

The requirement for Average
Speed of Answer (ASA), as
defined when building the
forecast. Immediate activity or MSA

Avg Speed of Answer The forecast Average Speed of
Answer (ASA) , which is
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Secondary data type Description Displays in menu if selected
object is:

calculated using Staffing
Calculated values.

Avg Speed of Answer
Required

The forecast Average Speed of
Answer (ASA), which is calculated
using Staffing Required values.

% of Abandons Objective
The requirement for the
percentage of interactions
abandoned, as defined when
building the forecast.

% of Abandons
The forecast percentage of
interactions abandoned, which is
calculated using Staffing
Calculated values.

% of Abandons Required
The forecast percentage of
interactions abandoned, which is
calculated using Staffing
Required values.

Maximum Occupancy
Objective

The requirement for the
maximum time that a logged-in
agent should be handling
interactions, as defined when
building the forecast.

Maximum Occupancy
The forecast maximum time that
a logged-in agent will handle
interactions, which is calculated
using Staffing Calculated values.

Maximum Occupancy
Required

The forecast maximum time that
a logged-in agent will handle
interactions, which is calculated
using Staffing Required values.

Editing data in the grid

In the Scenario > Staffing grid, WFM enables you to edit forecast staffing data. You can edit time
steps and daily totals when the selected period is Week and edit weekly and daily totals when the
selected period is Month or Year.

When changing the period, granularity, and/or values in the grid, note that daily totals are
aggregated values for a 24-hour period. This means the daily and weekly totals automatically adjust
and are redistributed according to the original distribution of staffing for each day of the week or
week of the month/year. This is useful if you have a week in which you believe the staffing will
increase, but you expect the staffing to arrive at about the same rate as in your original forecast,
day-over-day.
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Editing modes
WFM provides two editing modes in the Staffing grid. Single-clicking a cell puts it into quick-editing
mode and double-clicking a cell puts it into deep-editing mode. You can use either method for all
editing functions.

Navigating the grid
In the grid, you can move from cell to cell by using the Enter or Shift+Enter keys on the keyboard.
Click a cell and press:

• the Enter key to move the focus to the cell below the one selected.
• the Shift+Enter keys to move the focus to the cell above the one selected.

If you select a cell in the Daily total row, you can use Enter to move down one cell, but you cannot
use Shift+Enter to move up one cell.
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To edit the Calculated or Required data:

1. Click (or double-click) the cell you want to change and enter a value.
2. When you have finished, in the upper-right corner of the view, click Save (or use the hotkey combo

Alt+S).
A message appears in the lower-right corner, indicating your changes were saved
successfully.

If you switch to another view without saving the changes, a dialog opens with the message Would
you like to save changes to <scenario name>. Click:

• Save to save the changes and switch to another view.
• Discard to discard the changes and switch to another view.
• Cancel to cancel the action, close the dialog, and return to the Staffing view.

From the Save menu, you can also select:

• Publish (Alt+P) if you have modified the scenario data and want republish it.
• Save as template... to save this scenario as a template.
• Close (Alt+W) to close the scenario.

Selecting data to copy and paste

Tip
If you are unable to copy/paste, ask your administrator to confirm that your
environment is using HTTPS secure connections to WFM. See the Workforce
Management Administrator's Guide.
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Use Copy and Paste in the toolbar or use the Ctrl-C and Ctrl-V key combinations on your keyboard to
select data in the Staffing view grid for copying and pasting. You can copy/paste within the grid and
to/from documents, such as Excel or Notepad. You can also copy and paste data from Master
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Forecasts and other scenarios.

Copy and Paste are enabled in the toolbar when you select a single cell or a range of cells. When
selected, cells are highlighted and bordered with a bold solid line. When copied to the clipboard, they
are bordered with a dashed or broken line. Targeted or pasted cells are highlighted and bordered with
a bold solid line.

When you copy empty cells together with cells that contain values, they are pasted as empty cells,
overwriting any original values.

For some key combinations, you must select values in the Daily totals row, Time step column, and
Date column (when the selected period is Month or Year) separately. They cannot be selected with
other rows or columns in the grid. Also, time step values and dates can be pasted only to external
sources (not into the grid). You cannot select, copy, or paste the Time step header row (Mon , Tue.
etc.).

The grid scrolls automatically when you select a range of cells using the Arrow, Home, End, Page Up,
or Page Down key, or the Shift+Arrow, Shift+Home, Shift+End, Shift+Page Up, or Shift+Page Down
keys.

If you select more cells to copy than you select for paste, only a part of data is pasted. See more
information about these functions in Managing templates.

Paste is disabled when:

• Nothing is selected in the grid
• A business unit or site is selected in the Objects pane. Select an activity or multi-site activity to enable

it.
• Cells/values are selected for dates that are outside of the scenario date range.

Attempts to paste any of the following invalid values into the grid or Daily totals/Average row
results in the message: Cannot paste invalid values.

• Letters, special symbols, or negative values
• Decimal values that have more than 2 digits after the period. For example, 1525.423
• Non-integer values for time steps when Week and 15-minute granularity is selected
• Values that are out of range

Using the Scenario Staffing toolbar

Use the following buttons on the toolbar (above the graph) to modify and manage staffing data:
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Icon Name Description

Copy Copies data selected in the grid
to the clipboard.

Paste Pastes data from the clipboard to
the selected area in the grid.

Build
Opens the Build Staffing wizard,
enabling you to build staffing
data for the selected activity.

Add activities
Opens the Add Activities dialog,
enabling you to add activities to
scenarios.

Remove activities
Opens the Remove Activities
dialog, enabling you to remove
activities from scenarios.

Split
Opens the Split Staffing wizard,
enabling you to splits staffing
data from a multi-site activity to
site-specific activities.

Required
Opens the Required Staffing
wizard, enabling you to set the
forecast's required number of
agents.
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Building staffing
In Workforce Management (WFM), you'll use the Build Staffing wizard in the Scenarios Staffing
view to build staffing data (define the number of agents) in forecast scenarios for a selected single-
site activity or multi-site activity, based on parameters that you provide.

To open this view, click Forecast > Scenarios. The Scenarios view opens, displaying a list of
scenarios in a table. Open a scenario; You'll see the Volumes view by default. Switch to the Staffing
view by clicking the drop-down menu beside the scenario's name.

Before you begin
Before using the Build Staffing wizard to build a staffing forecast, take these required actions:

• Use the Build Volumes wizard to build interaction volumes and AHT for activities and/or multi-site
activities.

• If you plan to use templates, create them.

Be aware that even if there is IV and AHT data for child activities, this wizard does not build a staffing
forecast for the parent multi-site activity.

For information about building staffing forecasts for multiple activities, see Building staffing for
multiple activities.

Building staffing data

You must understand the difference between the following types of activities (mentioned in this
procedure) so you can enter/choose optimal values for the activity you are staffing:

• Immediate—Work activities that are handled by agents immediately, such as voice calls.
• Deferred—Backlog activities, such as email, that use special forecasting calculations.
• Fixed-staff—Non-CTI activities that do not use Workforce Management service objectives.

In some cases, the Build Staffing dialog displays values that were used for the most recent staffing
build or the default forecasting objectives values (if these have been specified and there were no
previous builds). Otherwise, the parameter values are left blank. You can also save the values of
certain parameters as the new default service level objectives (for more information, see Save
default service level objectives).
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Step 1: Build staffing data

1. In the scenario's Staffing view toolbar, click Build .
The Build Staffing dialog opens.

2. Enter the target date range in the Start date and End date fields.
The scenario's start and end date displays, by default.

3. In the Indirectly occupied time section, click one of two radio buttons:
• Use value—Enter a value (for example, 0 to 99%).

• Use template—Click Edit and when the Select Templates dialog opens:
• In the template name field, click the down arrow to select a template from the list.
• Enter the start and end dates or click the calendar icon to select them.
• Remove the check mark from the days of the week that are not applicable to this template.
• Click Add template to add more templates, if necessary.
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If there are no templates available you must create them. See Before you begin.

• • Select Save indirectly occupied time to default SL objectives if you want to save the value
you have specified as the default IOT value.

1. Enter a value in the Initial queue field. Select the Save initial queue time in default SL properties
if you want to save the value that you have specified as the new default service level value.
This setting displays, only if you are staffing a deferred activity or multi-site activity.

2. Choose one of the save options for the Save default SL objectives setting. This setting only displays
if you are staffing an immediate single or multi-site activity. For more information, see Save default
service level objectives).

3. Select Compare results against previous if you want to compare this staffing build with an existing one.
Otherwise, leave the check box as is.

4. Click Next.
Step 2 of the dialog opens.

Step 2: Choose a method
The settings you see in the Build Staffing wizard Step 2 depend on the type of activity you are
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staffing.

1. If you are staffing:
• An Immediate activity, select the build method. See either Defining service requirements or Defining

staffing requirements.
• A Deferred activity, see Defining multimedia service level objectives.
• A Fixed-staff activity, see Defining staffing requirements.

2. Fill in each screen that opens, and then click Finish.
3. If you selected Compare results with previous in Step 1 of the Build Staffing dialog, the Scenario

Build Results window opens.

Next step:

• Publish the scenario to the Master Forecast. For details, see Publishing the forecast scenario.

Defining service requirements

If you select Service requirements for the build method in the Build Staffing wizard, use the
following settings to define service level objectives when staffing Immediate activities. When you
select an objective's check box, you enable the text boxes for these target levels.

In some cases, you might want to use a template if the values for the objective are different for
certain time steps. Otherwise, WFM uses the single value that you configure, and applies it across all
open hours of the activity.

Forecasts Scenarios

Workforce Management Supervisor Help 111



1. In Step 2 of the Build Staffing dialog, select the check box(es) for one or more of the following:
• Use service level objective answered in sec—Specify the percentage of calls you want

answered in a specific number of seconds. For example, 80% of calls must be answered in 20
seconds.
• Immediate work—Enter a value (%) or
• Use template—Click Edit to select a template from a list.

• Use average speed of answer objective—Specify the average amount of time it takes for an
agent to answer a call.
• ASA in "sec"—Enter a value (seconds) or
• Use template—Click Edit to select a template from a list.

• Use estimated average time to abandon in sec—This is not a service objective. It's a
parameter that helps define the queuing system used when WFM builds staffing requirements. This
value represents the average time it takes for impatient callers to abandon the call.
• Use abandoned interaction objective—Check this box to enable it and
• Maximum percent of interactions abandoned—Enter a value (%).

• Use occupancy objectives—The total amount of time the agent is actually working on an activity
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as a percentage of the total amount of time the agent is available to work on an activity. See the
example.
• The maximum occupancy rate (%).—Enter a value (%) or
• Use template—Click Edit to select a template from a list.

2. If you want to update the default service level objective values with the new values you have specified,
select the Update activity default SL objective option for each parameter you want to update. For more
information, see Save default service level objectives).

3. When all requirements are defined, click Build.
WFM Web calculates staffing and displays the data in the Staffing view. An error message
appears if WFM Web cannot complete the calculation.

Example—Occupancy objectives:
Assume an agent has a shift from 8am-5pm, with a 30-minute lunch and 2x15-min breaks. Although
the agent's total shift duration is 9 hours, the total amount of time the agent is actually available for
work is 8 hours, after subtracting the time for the lunch and breaks.

Defining staffing requirements

If you select Staffing requirements for the build method in the Build Staffing wizard, use the
following settings to define how staffing requirements are built for Immediate activities, if you do not
define any service objective, or for Fixed-staff activities.
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1. In Step 2 of the Build Staffing dialog, select one of the following options:
• Number of agents at each timestep—Enter a value for the number of agents.
• Average activity handling time in "sec"—Enter a value (seconds).
• Use staffing template—Click Edit to select a template from a list.

Select the Save in default objectives check box if you want to update the default staffing
requirement values with the new values you have specified.

2. When all requirements are defined, click Build.
WFM Web calculates staffing and displays the data in the Staffing view. An error message
appears if WFM Web cannot complete the calculation.

Defining multimedia service level objectives

If you select Multimedia service level objectives for the build method in the Build Staffing
wizard, use the following settings to define service level objectives when staffing Deferred activities,
such as responding to emails. Use either one of the following procedures:
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1. In Step 2 of the Build Staffing wizard:
• Enter a value (%) for Deferred work or
• Select Use service level template and click Edit to select a template from a list.

Select the Save deferred work in default SL properties check box if you want to save the
values you have specified as the default service level objective values for this setting.

2. Enter Time based on:
• Hours and select either Non-interrupted time or Interrupted time or
• Business days and enter an integer greater than 0.

Select the Save deferred time in default SL properties check box if you want to save the
values you have specified as the default service level objective values for this setting.

3. When all objectives are defined, click Build.
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Understanding the build staffing settings

Use Build Staffing dialog to specify the settings described below.

Indirectly occupied time
Indirectly occupied time (IOT) is a parameter that helps to define the queuing model that WFM uses
when building a staffing forecast. WFM considers a certain pool of agents in its queuing model when
determining how calls will be distributed from the queue to agents. IOT affects the availability of
agents to handle calls. For example, if you enter a value for IOT, such as 10%, an agent will not be in
the agent pool 10% of the time (because the agent is off the phone).

Alternatively, you can define IOT by using a template.

Compare results against previous
If you selected the Compare results against previous check box in the Build Staffing wizard Step
1, WFM compares the results obtained from the wizard with the previous staffing scenario results.

If you selected a Deferred activity, the Initial queue field displays. Enter an integer value that is 0 or
greater, or leave this value empty and the build process will assume that the value is 0.

After you have completed the steps in the wizard, the Staffing Build Results window opens, showing a
comparison of the new and previous calculated staffing in a graph.

Where the new calculated staffing results in:

• An increased number of agents, the graph shows the area in dark blue.
• A decreased number of agents, the graph shows the area in rose.

Click Save to keep the new calculated staffing in your scenario or Discard to return to the original
calculated staffing values.

What is the initial queue value?
The initial queue value is used in the Contact Center Performance Report > Queue > Forecasted
column for the first day of the new forecasting period after you publish the Master Forecast. For
example, if you have published the Master Forecast for 02/02 - 08/02, the Forecasted column for 09/
02 displays the backlog value that is proposed in the Staffing Forecast Build wizard for 09/02 in the
Initial queue field.

The Initial queue field is visible only for Deferred activity types.

Save default service level objectives
If you are building staffing for a single (or multi-site) Immediate activity type, you can choose to
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update some or all of the default service level objectives with the new values you have specified. You
can choose which parameter values to save as the new defaults by selecting the Update activity
default SL objective option in the Build Staffing dialog for each parameter you want to update.
You can then apply the updates in one of two ways:

• Remove all is the default setting. For each parameter where the Update activity default SL
objective option is selected, the default service level objective value for that parameter is updated to
the new specified value while the default values (or templates) for all other parameters are cleared.

• When Append selected is selected, the default service level objective value for each parameter where
the Update activity default SL objective option is selected is updated to the new specified value.
The default values for all other parameters remain unchanged.

If you do not select the Update activity default SL objective check box for any parameters, the
default values remain unchanged.

Important
If you are using templates to specify the parameter values, you can select only one
template to save when choosing to update the default service level objectives for the
activity. WFM Web will prompt you to choose the template you want to save. The
staffing will be built according to the values of all selected templates, but only the
template selected to be saved will update the default service level objective value.
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Building staffing for multiple activities
In Workforce Management (WFM), you'll use the Build Staffing in the Scenarios Staffing view to
build staffing data for multiple activities.

To open this view, click Forecast > Scenarios. The Scenarios view opens, displaying a list of
scenarios in a table. Open a scenario; You'll see the Volumes view by default. Switch to the Staffing
view by clicking the drop-down menu beside the scenario's name.

When you select a Site or Business Unit (BU), you are able to build staffing for multiple activities
based on the Default Forecasting Objectives that were defined for each activity type (Immediate,
Deferred, Fixed-Staff).

Before you begin
Before using the Build Staffing wizard to build a staffing forecast for multiple activities, use the
Default Forecasting Objectives to set the default forecasting objectives for each activity type
(Immediate, Deferred, Fixed-Staff).

Building staffing data for multiple activities

The Build Staffing wizard uses the Default Forecasting Objectives that were defined for each of the
following activity types (for activities under sites and multi-site activities):

• Immediate — Work activities that are handled by agents immediately, such as voice calls.
• Deferred — Backlog activities, such as email, that use special forecasting calculations.
• Fixed-staff — Non-CTI activities that do not use Workforce Management service objectives.

You won't be able to make changes to these values when using the wizard to build staffing for
multiple activities.

To get started, select a Site or BU from the Activities list. In the scenario's Staffing view toolbar,

click Build ( ) to launch the Build Staffing wizard.
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Step 1: Select target dates

• Select the Start date and End date for the target date range. By default, the scenario's start and end
date displays.

• Click Next.
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Step 2: Choose activities

• Expand business units to display their sites and activities.
• From the list of activities, select the activities you want to build staffing data for.
• Click Build.
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Required and split staffing methods
Workforce Management (WFM) provides different methods to staff (define the number of agents
required for) forecast scenarios, such as Required and Split Staffing.

Required staffing is a user-defined data series that you build, by using the Required Staffing wizard.
The Split Staffing wizard enables you to split the number of agents required for a multi-site activities
(MSA) into specific amounts for each activity within the MSA.

Using required staffing values

Use the Required Staffing wizard to define required staffing values in a forecast scenario's Staffing
view.

Here's what you should know about required staffing and how you can use it:

• Required staffing data is user-defined staffing requirements for a forecast scenario.
• If you have compiled calculated-staffing values, you can set required staffing to the same values as

calculated staffing.
• Forecasts can contain both calculated and required data. You can build schedules by using either set of

data.
• Required staffing can be composed of a combination of template values, manually entered amounts,

and calculated staffing values.

Tip
Before selecting the template in this wizard, create templates as needed.
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To set required staffing by using the wizard:

1. In the navigation bar, click Forecast > Scenarios.
The Scenarios view opens.

2. Beside the scenario you want to staff, click Actions and then, select Open.
3. At the top, near the scenario name, click the Volumes drop-down menu and select Staffing.

4. In the Activities pane, select an activity or multi-site activity and click Required .
The Required Staffing wizard opens.

5. Choose one of four build methods:
• Select Load calculated staffing to apply calculated staffing to required staffing with no changes.
• Select Load calculated staffing, adjusted by and enter a percentage to adjust calculated staffing

before applying it to required staffing.
Valid values are from -99 to 999.

• Select Load calculated staffing adjusted using shrinkage and click Edit to adjust
calculated staffing, before applying it to required staffing.
1. When the Select shrinkage profile dialog opens, select the check box beside the profiles you

want to use, or select the top-most check box to select all profiles.
2. Click OK to return to the Required Staffing dialog. The Load calculated staffing adjusted

using shrinkage field is updated with the number of profiles you selected.

• Select Use templates and click Edit to apply one or more staffing templates
1. When the Select Template dialog opens, click the down arrow in the empty field to select a

template.
2. To add another template, click Add template.
3. For each template, enter a start and end date, or use the date selectors to set these fields.
4. Deselect the check boxes for the week days that are not applicable.
5. Click OK to return to the Required Staffing dialog. The Use templates field is updated with

the number of templates you selected.

6. Click Load.
7. When the loading process is complete, click OK.

Splitting the staffing data

Use the Staffing Split Wizard to split staffing from a multi-site activity Staffing forecast scenario.

A multi-site activity (virtual activity set) has one or more associated activities (existing activities).
After building calculated and required staffing for a multi-site activity, you can then use this wizard to
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split the result between associated activities.

Tip
The Staffing Split Wizard is available only within a Forecast Scenario. You must
add a multi-site activity to the forecast scenario for them to be available for splitting
in Staffing Split Wizard.
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To split staffing for a multi-site activity:

1. In the navigation bar, click Forecast > Scenarios.
The Scenarios view opens.

2. Beside the scenario you want to staff, click Actions and then, select Open.
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3. At the top, near the scenario name, click the Volumes drop-down menu and select Staffing.

4. In the Activities pane, select multi-site activity and click Split .
The Split Staffing wizard opens.

5. Using the check box, select the multi-site activity that you want to be split between associated
activities.
You can select several multi-site activities within the same business unit.

6. Select Use AHT forecast if you want WFM Web to consider average handling time forecasts when
performing the split and then, click Next.
Step 2 of the wizard opens.

7. At the bottom of the pane, select Split required also, if you also want to split required staffing.
8. Select the local (target) activities into which you want to split the multi-site activities and then, click

Next.
Step 3 of the wizard, Specify budgeting data, opens.

9. If you want each activity to have the same values, in the top row:
1. Select and enter the Working hours (paid hours per day).
2. Select and enter the Hourly wages.
3. Click Set all.

10. If you want activities to have different values, enter Working hours and Hourly wages for each
activity, individually.

11. Click Split.
WFM Web displays a progress dialog while it splits the activities.

12. When the split process is complete, click OK.

You can click Cancel in this dialog at any time, if you want to cancel the split.
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Shrinkage in scenarios
In Workforce Management (WFM) you'll use the Shrinkage view (formerly named Overheads) to view
overhead data, which WFM uses to forecast shrinkage while scheduling.

This view provides standard date-selectors and a grid that shows shrinkage percentages for days and
timesteps.

You can perform the following functions in this view:

• View shrinkage totals
• Add and delete shrinkage associated with the current Schedule State Group for a specific activity
• Edit shrinkage associated with the current Schedule State Group for a specific activity

Viewing the shrinkage data

Open the Shrinkage view by using the scenario's drop-down menu (see below). Scenarios open to
the Volumes view by default.
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To open the Shrinkage view:

1. In the Forecast module, select Scenarios.

2. Select a scenario from the list in the data pane, and click Open in the toolbar or in the Actions
drop-down menu.
The Volumes view opens by default with the scenario name in the top-left corner of the
window.

3. Click the scenario's drop-down menu and select Shrinkage.
4. In the Objects tree, expand a business unit, then a site to select an activity, or multi-site activity.

The view displays a graph above a table or grid, each containing the same shrinkage values,
and controls that set the data display properties for the graph and table.

Link to video
If you have not selected an activity, you'll see the message Select an activity within the nested tree
to load shrinage. If you still do not see any data, you might need to adjust the Period, Granularity, or
date-selectors at the top of the window to reflect those used for the forecast.

You can also view, add, and edit the volumes or staffing data in opened scenarios, by selecting
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Volumes or Staffing from the drop-down menu near the scenario name.

Setting the data display properties

In this view, the graph's y-axis represents the shrinkage percentage; the x-axis represents the
selected period (week, month, year). Use the following controls to customize the data display in the
graph and table:

Forecasts Scenarios

Workforce Management Supervisor Help 129



• Shrinkage type drop-down list—Select the shrinkage type that will be displayed as primary, by
selecting Grand total, Total planned, or Total unplanned.
If you select a business unit or site, you see only the first three shrinkage types. If you
select an activity that is associated with a Schedule State Group (SSG), the SSG appears in
the list. If you select a multi-site activity that has a child activity that is associated with a
SSG, Schedule State Group<activity name> appears in the list.

• Period drop-down list—Change the period or time range for the graph and grid by selecting Year,
Month, or Week.•
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Granularity drop-down list—Adjust the granularity to Day if you selected Month or Year in the
Period drop-down list. Adjust the granularity to 15, 30, or 60 (minutes) if you selected Select Week in
the Period drop-down list.

• Date range—Use the date-selectors (top-right portion of the view) to switch to a different period within
the scenario forecast's date range.

• Actions drop-down menu—Click this icon to change the graph:
• Graph options—Show/hide the graph and zoom bar by selecting/clearing the Show graph check

box. See also Sliders.

Watch the video demonstrating how the following features work. (The smooth graph feature
described in the first half of the video is not available this view.)

• Sliders—Drag the vertical slider left/right to show/hide the graph, zoom bar, grid and/or Objects pane.
Click the arrows in the vertical slider to resize the Objects pane. Drag the horizontal slider up/down to
show/hide the graph and/or grid.

• Zoom bar—Use the zoom bar handles to narrow or widen the focus in the graph, by sliding the handle
left or right. You can zoom to a minimum of one day. After narrowing the focus, place your cursor over
the graph and change the range of the zoom by dragging and dropping it to the left or right. For
example, if you narrow the focus to Sunday, Monday, and Tuesday, but want to change it, drag and
drop the zoom to the right to Tuesday, Wednesday, Thursday.
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Reading the data

The table provides columns that display the following statistics:

• Daily total—If you select the period Week, this row shows daily totals for shrinkage.
• Weekly total—If you select the period Month or Year, these columns show the weekly totals for

shrinkage.
• Date/Time step—Identifies the range of dates or timesteps in this row. The column name and contents

will differ, depending on the period and granularity you selected above.
• [Days or Dates]—If you select the:

• Week date range—Each group of columns indicates one day. The top row shows daily totals and
each lower row shows statistics for one timestep on that date.

• Month date range—Each group of columns shows shrinkage for one full day.
• Year date range—Each group of columns shows shrinkage for one full day.

Timestep durations depend on the granularity that you selected above.
• Shrinkage type—If you select:

• Grand Total—A read-only statistic; the aggregate shrinkage for the selected target.
• Total Planned—A read-only statistic; the aggregate planned shrinkage for the selected target.
• Total Unplanned—A read-only statistic; the aggregate unplanned shrinkage for the selected target.
• <name>—The name of the Schedule State Group (SSG) when an activity is selected (for example

My Meeting). Indicates shrinkage values that are associated with this SSG and the target. If the
target is a multi-site activity, the activity name is prefixed with the SSG name (for example
Schedule State Group<activity name>).

WFM displays shrinkage for the item that is selected in the Object pane. If the item is an activity,
then the Shrinkage type list shows the Schedule State Groups that are associated with the activity.
If the item is a multi-site activity, the menu lists all Schedule State Groups that are associated with its
child activities.

You can edit shrinkage values for activities or multi-site activities. See Editing data in the grid.

Editing data in the grid

WFM enables you to edit forecast shrinkage data in the Scenario > Shrinkage grid:

• Enable editing in the grid by selecting an activity.
• Edit a multi-site activity by selecting and editing one of its child activities. (You cannot edit a multi-site

activity directly.)
• Edit time steps and daily totals by selecting the period Week
• Edit weekly and daily totals by select the period Month or Year.
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If you select Grand total, Total planned, or Total unplanned, editing values in the grid is disabled.

When changing the period, granularity, and/or values in the grid, note that daily totals are
aggregated values for a 24-hour period. This means the daily and weekly totals automatically adjust
and are redistributed according to the original distribution of shrinkage for each day of the week or
week of the month/year. This is useful if you have a week in which you believe the shrinkage will
increase, but you expect the shrinkage to arrive at about the same rate as in your original forecast,
day-over-day.

Editing modes
WFM provides two editing modes in the Shrinkage grid. Single-clicking a cell puts it into quick-editing
mode and double-clicking a cell puts it into deep-editing mode. You can use either method for all
editing functions.

Entering invalid values
The Shrinkage grid does not accept invalid values. In most cases, WFM attempts to convert certain
characters or symbols into a valid value. Here are some examples:

• If you enter a value similar to 1.$#!5, WFM converts it to 1.50%.
• If you enter a value a negative percentage, such as -88%, WFM converts it to 88%.
• If you enter a value greater than 99.99%, such as 899%, WFM converts it to 89%.
• If you enter a value with more than two digits after the decimal point, such as 40.009812%, WFM

converts it to 40.00%.

Navigating the grid
In the grid, you can move from cell to cell by using the Enter or Shift+Enter keys on the keyboard.
Click a cell and press:

• the Enter key to move the focus to the cell below the one selected.
• the Shift+Enter keys to move the focus to the cell above the one selected.

If you select a cell in the Daily total row, you can use Enter to move down one cell, but you cannot
use Shift+Enter to move up one cell.
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To edit the shrinkage data in the grid:

1. Double click the cell you want to change and enter a value.
2. When you have finished, in the upper-right corner of the view, click Save (or use the hotkey combo

Alt+S).
A message appears in the lower-right corner, indicating your changes were saved
successfully.

If you switch to another view without saving the changes, a dialog opens with the message Would
you like to save changes to <scenario name>. Click:

• Save to save the changes and switch to another view.
• Discard to discard the changes and switch to another view.
• Cancel to cancel the action, close the dialog, and return to the Shrinkage view.

From the Save menu, you can also select:

• Publish (Alt+P) if you have modified the scenario data and want republish it.
• Save as template... to save this scenario as a template.
• Close (Alt+W) to close the scenario.
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Selecting data to copy and paste

Tip
If you are unable to copy/paste, ask your administrator to confirm that your
environment is using HTTPS secure connections to WFM. See the Workforce
Management Administrator's Guide.

WFM enables you to copy and paste data to/from the shrinkage grid. Selecting data in the grid
enables the Copy button. After copying, a message appears indicating that data was copied to the
clipboard. Selecting other cells in the grid enables the Paste button.
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To copy and paste data in the grid:

1. Open a scenario and select the Shrinkage view.
2. In the Objects pane, expand the list to select an activity or multi-site activity.

If you select a multi-site activity, Paste is disabled. You can only paste activities.
3. In the grid, select the cells that you want to copy.

4. In the toolbar, click Copy .
5. In the grid, select the cells into which you want to paste.

6. In the toolbar, click Paste .
7. In the upper-right corner of the view, click Save.

When copying/pasting values in the Shrinkage view:

• You must copy/paste the Daily totals/Average row separately. It cannot be copied or pasted with other
rows.

• Attempting to paste some letters, symbols, negative values, or values greater than 99.99 into the grid
generates the message Cannot paste invalid values.

• You can copy/paste within the grid or to an external source, such as Excel or NotePad.
• Paste is disabled when:

• The selected object is a business unit or site.
• The Shrinkage type selected is Grand total, Total Planned, or Total Unplanned.
• The selected cells for weekdays are outside the scenario weekdays.

You can also use the Ctrl-C and Ctrl-V key combinations on your keyboard to select data in the
Shrinkage view grid for copying and pasting.

Using the Scenarios Shrinkage toolbar

Use the following buttons on the toolbar (above the graph) to modify and manage shrinkage data:

Icon Name Description

Copy Copies data selected in the grid
to the clipboard.

Paste Pastes data from the clipboard to
the selected area in the grid.
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Icon Name Description

Add activities
Opens the Add Activities dialog,
enabling you to add activities to
scenarios.

Remove activities
Opens the Remove Activities
dialog, enabling you to remove
activities from scenarios.

Add shrinkage

Opens the Add Shrinkage dialog,
enabling you add shrinkage to
Schedule State Groups that are
associated with activities or
multi-site activities.

Apply template
Opens the Apply Template dialog,
enabling you to add shrinkage to
Schedule State Groups by
applying a template.
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Managing shrinkage data
In Workforce Management (WFM) you'll manage the shrinkage data (previously named overheads) in
Forecast Scenarios, by adding, editing and deleting shrinkage associated with the Schedule State
Group (SSG) for a specific activity. You can also apply templates to make adjustments to the
shrinkage data.

Multi-site activities (MSA) use shrinkage information that is associated with Schedule State Groups
from child activities.

Statistics appear in the Shrinkage type drop-down menu for the item that is selected in the
Objects pane. If the item is an activity, then the menu lists all Schedule State Group shrinkage that
is associated with the activity. If the item is a multi-site activity, the menu lists shrinkage for all
Schedule State Groups that are associated with the child activities. You must edit the shrinkage
values for child activities of the MSA individually.

If you select an activity or MSA for which there are no available Schedule State Groups, after clicking
Add Shrinkage, you'll see the message There are no available schedule state groups in the dialog.

Adding and deleting shrinkage

Adding shrinkage in forecast scenarios means adding shrinkage values that are associated with a
Schedule State Group (SSG) and a target, such as an activity. Deleting shrinkage means deleting
these values in the Shrinkage type menu. Once you confirm the deletion of these values, the SSG is
removed from the Shrinkage type menu. Use the procedures below to add and delete shrinkage.
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Adding shrinkage to activities
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To add shrinkage to an activity in a scenario:

1. Open the Shrinkage view
2. In the Objects pane, expand business units and sites to select an activity.

3. In the toolbar, click Add shrinkage .
The Add Shrinkage for <Activity_name> dialog opens.

4. Select a Schedule State Group from the list.
5. Choose one of these options:

• In the Initial value field, enter a percentage.

• Click the Select templates radio button and click Edit .
The Select Templates dialog opens.
1. Select a template from the drop-down list.
2. Enter (or use the date selectors to adjust) the Start date and End date, if necessary.
3. Uncheck any days of the week that are not applicable for this template.
4. To add more templates, click Add template, repeating substeps 2 and 3 for each one.
5. Click OK.

The wizard returns to the Add Shrinkage for <Activity_name> dialog.

6. Click Add.
WFM confirms that the shrinkage was successfully added, and the shrinkage appears in the
graph and grid.

Click Cancel or X in the upper-right corner of the dialog to cancel the action and close the dialog.
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Deleting shrinkage from activities

To delete shrinkage from an activity in a scenario:

1. Open the Shrinkage view
2. In the Objects pane, expand business units and sites to select an activity.
3. Click the Shrinkage type drop-down menu and select the Schedule State Group you want to delete.
4. In the selected SSG's submenu, click Delete.
5. A confirmation dialog opens.
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Click Delete.
The shrinkage is deleted from the graph and grid for the selected activity.

6. Alternatively, click Cancel to cancel the action and close the dialog.

Adding shrinkage by applying templates
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To add shrinkage to Schedule State Group by applying a template:

1. Open the Scenario > Shrinkage view
2. Click the Shrinkage type drop-down list to select a Schedule State Group.

3. Click Apply templates .
The Apply Templates dialog opens.

4. In the Select template field, select the template you want to apply.
5. Change the start and end date, if necessary.

Ensure the dates are not outside of the scenario start/end dates.
6. Uncheck any days of the week that you do not want impacted by this template.
7. To add more templates, click Add template, repeating steps 4 to 6 for each one.
8. Click Apply.
9. When the process is complete, click OK.

Click Cancel or X in the upper-right corner of the dialog to cancel the action and close the dialog.
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Templates

Tip
This page describes Templates in the new Workforce Management (WFM) Forecast
module interface (introduced in 8.5.2). If you are using the classic Supervisors
interface and have landed on this page by accident, see the Workforce Management
Web for Supervisors Help (Classic), which describes the classic Forecast module,
including templates.

WFM Forecast templates help you create forecasts for sites or business units that have little or no
historical data. In addition, there are other uses for templates. For example, you can create templates
for service requirements, such as average speed of answer (ASA), and service level (SL). In those
cases, forecast templates are used to apply different values for different periods of the day, instead
of using a single value for the whole day.

Use the Forecast templates features to:

• Select and manage forecast templates.
• Edit template values and settings.
• View template values in a graph.
• Add or remove activities within templates.
• Create templates.
• Create templates based on existing data.

Tip
You must have the access permission to the Templates view before you can view,
create, or modify templates. See also, the Tip about access permission in Navigating
the Forecast views

When creating templates, you can copy and paste data between a grid and a spreadsheet. For
example, you can copy and paste from a Scenario Volumes view or Scenario Staffing view.
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Opening the Templates view

You create, edit, filter, and delete forecast templates in WFM's Forecast module, by selecting
Forecast > Templates.

When you open this view initially, you might not see any templates listed (see figure). WFM displays
a list of associated templates only after you select a business unit or site in the Objects pane.

If no templates exist for the selected object, you'll see the message No items to display. Either create
a template for the selected object or choose another object to view it's templates.

Working in the Templates view

The Templates view is split into three panes.
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The Objects pane displays a hierarchical list of business units and sites in the enterprise. In this
pane:

• Select a business unit or site (by clicking the arrow > beside the business unit) to see a list of templates
for the selected object.

The Templates pane displays the name of the selected business unit or site and a table containing
its templates. In this pane:

• Select an template to display its tabs in the Data pane.
• Create a template. Click New template in the toolbar.

If there are no templates for the selected object, the message No items to display appears
in the middle of the pane.

• Delete templates. Check the boxes to select one or more templates and click Delete in the toolbar.

• Filter the list of templates to display only the template types you want to see.
• Use the paging controls to navigate through lists of templates that are more than one page long.

The Data pane displays three tabs: Properties, Distribution, and Activities. In this pane:

• View the settings and controls for any of the three tabs, or change their settings.
The tab settings are described below.
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Understanding the template's data

The template data can be viewed and edited by using the following three tabs:

Properties tab

The Properties tab contains two fields:

• Name—The name of the forecast template.
• Type—The template type. You choose the template type when you are creating templates. You cannot

edit this field.

The Name field is editable. Simply enter the new name and click Save.

Distribution tab
The Distribution tab displays a forecast template's values for a 7-day period in both graphical and
table format.
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To adjust the graph's displayed time interval, use the horizontal sliders.

The graph adjusts to display only the selected days (to a minimum of 1 day) and divides them into
timesteps, according to the number of days that are displayed.

In the grid, use the vertical scroll bar to see the following columns and rows:

• The Time step column is divided into 15-minute timesteps.
• The remaining columns show the days of the week.
• The top row shows is either the Total or Average daily value for each day of the week, depending on

the template type you've selected.
• The Total/Average daily value is displayed to the far right, above the table.

This cells in the grid are editable. Simply enter new values and click Save.
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Activities tab

The Activities tab displays the activities associated with a forecast template in a hierarchical format.

Clicking the top-most check box selects all of the site's activities.

Activities selection is editable in this tab. Simply select or deselect one or more check boxes and click
Save.

Selecting a template type

You select the template type when you are creating templates. Be sure to use acceptable values for
each type.
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You can filter the Templates grid by the following template types:

• IV—Represents interaction volumes by the number of interactions per timestep.
When you save historical IV or AHT for a multi-site activity as a template, only multi-site
activity data are saved, never the sum of underlying activities.

• AHT—Represents the average handle time, in seconds. See the IV description above.
• Staffing—Represented as the number of agents (full-time equivalents) to be scheduled for each

timestep.
This can be either calculated by WFM (Calculated Staffing) or set by the user (Required
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Staffing), or you can use both Calculated and Required values in a forecast. See Tip.
• Indirectly occupied time %—Represented as a percentage. See Tip.
• Service level %—Represented as a percentage. See Tip.
• Average speed of answer—Represented in seconds. See Tip.
• Maximum occupancy—Represents the agent's maximum occupied time, as a percentage.
• Shrinkage—Represents the amount of shrinkage or overhead, as a percentage.
• Split %—Represents how multi-site activities are split, as a percentage.

Tip
Create these templates at the business unit level and apply them when building a
multi-site activity staffing forecast.

Acceptable range of values in templates
Template type Acceptable values

Interaction volumes (IV) 0 to 999999999
Average handle time (AHT) 0.00 to 999999999.99
Staffing 0 to 999999999
Indirectly occupied time % 0.01 to 99.99
Service level % 0.01 to 100
Average speed of answer (ASA) 0.01 to 999999999.99
Maximum occupancy % 0.01 to 100
Shrinkage % 0.00 to 99.99
Split % 0.00 to 100.00
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Managing templates
In Workforce Management (WFM), you'll use forecast templates to help you create forecasts for sites
or business units that have little or no historical data, and other uses. This topic describes the WFM
wizards, controls, and settings you'll use to view, create, and manage these templates.

The templates you create using these procedures can be used only for the activities or multi-site
activities (MSA) you select in Step 2 of wizards. If you select any other activity or MSA, you won't see
the template.
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Creating forecast templates

To create forcast templates:

1. In the Forecast > Templates view, select:
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• A business unit if you are creating the template for multi-site activities.
• A site if you are creating the template for activities.

2. Click New template.
Step 1 of the New Template dialog opens.

3. Enter a Name for the template (limited to 127 characters)
4. Select the template type from the Type drop-down list.

See a list of template types here.
5. Enter a number in the Initial value text box.

See the Tip below for more information.
6. Click Next.
7. In Step 2 of the dialog, select the activities or multi-site activities for this template.
8. Click Create.
9. When the confirmation message appears, click OK.

Your template displays in the list of templates.

Tip
The initial value is a minimum value that applies to all timesteps. After you've created
the template, edit it to adjust the precise values for each timestep.

WFM Web interprets the initial value differently, depending on the type of template you choose. For
example, templates of type IV (interaction volume) could have an initial value between 0 and 9999999
(calls per timestep). However, templates of type Maximum occupancy could have an initial value
between 0.01 and 100.00 percent.

For more information about all acceptable values, see Acceptable values in templates.

Creating templates based on existing data

Use the Create Based On dialog to create a new forecast template from existing data.

When creating templates using this dialog, you'll notice (in Step 1) that the Type and Initial value
fields are disabled and the Copy data check box is checked, by default. WFM assumes that you want
to use the same data that was used in the source template. If you don't want to, simply uncheck the
Copy data check box and change the template type and/or initial value.
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To create a template based on an existing data:

1. In the Forecast > Templates view, select a business unit or site.
The templates for this object are displayed in a table.

2. Choose a template, click Actions , and select Create based on....
3. In Step 1 of the dialog, in the Name field, enter the template name (limited to 127 characters).
4. In the Type drop-down list, select the template type.

See a list of template types here.
5. Enter a number in the Initial value field.

See the Tip above for more information.
6. Remove the check mark in the Copy data check box if you do not want to copy data from the source

(based on) template.
7. Click Next.
8. In Step 2 of the dialog, select the activities or multi-site activities for this template.
9. Click Create.

10. When the confirmation message appears, click OK.
Your template displays in the list of templates.

Editing templates

In the Template Distribution grid, you can move from cell to cell by using the Enter or Shift+Enter
keys on the keyboard. Click a cell and press:

• the Enter key to move the focus to the cell below the one selected.
• the Shift+Enter keys to move the focus to the cell above the one selected.

If you select a cell in the Total or Average row, you can use Enter to move down one cell, but you
cannot use Shift+Enter to move up one cell.
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To edit a forecast template:
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1. In the Forecast > Templates view, select a business unit or site.
The templates for this object are displayed in a table.

2. In the table, select the template you want to edit.
The Data pane opens, displaying 3 tabs.

3. Click any tab to change its settings:
• In the Properties tab, enter a different name for the template. Note that you cannot change the

Type.
• In the Distribution tab, click any cell in the table to change its value. The Total/Average values

change to reflect any changes you make to the cell values and vice versa.
• In the Activities tab, add or remove activities by checking or clearing the check box next to the

activity.

4. When you are finished editing, click Save.
Alternatively, click Cancel at any time to discard any changes you've made.

When you are editing values in the Distribution grid, you can click the Esc key to cancel the action
(WFM does not change the value).

If you select a business unit or site, but do not select a template in the table, you'll see the message
Select template to edit in the Data pane.

See also, Selecting data to copy and paste.
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Deleting templates

To delete a template:
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1. In the Forecast > Templates view, select a business unit or site.
The templates for this object are displayed in a table.

2. In the table, select the template that you want to delete.

3. In the toolbar, click Delete .
4. When the confirmation dialog opens, click Delete to proceed or Cancel to cancel the action.

To delete multiple templates at once:

1. Select the templates you want to delete (using the check box beside each template).
2. Complete steps 3 and 4 in the procedure above.

To delete all templates in the table:

1. Select the top-most check box in the column header (near the Name column header).
2. Complete steps 3 and 4 in the procedure above.

If you are deleting a single template, the confirmation dialog contains the template name. If you are
deleting multiple templates, the confirmation dialog states the number of templates being deleted.
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Filtering templates in the table

To filter the templates in the table:
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1. In the Forecast > Templates view, select a business unit or site.
The templates for this object are displayed in a table.

2. In the Templates toolbar, click Filter .
The Filter By Type dialog opens with all templates types selected by default.

3. Deselect any template types you do not want to see in the list and click Apply.

When WFM displays the filtered list of templates, the color of the Filter icon changes to blue. If you
then select all template types and click Apply, the Filter icon changes to black.

If there are no templates found of the type you are filtering, you'll see the message No items to
display.

WFM preserves your filtered selections if you navigate to another view and return to the Templates
view.

Selecting data to copy and paste

Tip
If you are unable to copy/paste, ask your administrator to confirm that your
environment is using HTTPS secure connections to WFM. See the Workforce
Management Administrator's Guide.
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You can use key combinations on the keyboard and mouse to select data in the Template view's
Distribution grid for copying and pasting. You can copy/paste within the grid and to/from a document
(for example, Excel or NotePad).

For some key combinations, you must select the Daily values row and the Timestep column
separately. They cannot be selected with other rows or columns in the grid. Also, timestep values can
be pasted only to external sources (not into the grid). You cannot select, copy, or paste the Timestep
header row (Mon , Tue. etc.).

When selected, cells are highlighted and bordered with a bold solid line. When copied to the
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clipboard, they are bordered with a dashed or broken line. Targeted or pasted cells are highlighted
and bordered with a bold solid line.

The grid scrolls automatically when you select a range of cells using the Arrow, Home, End, Page Up,
or Page Down key, or the Shift+Arrow, Shift+Home, Shift+End, Shift+Page Up, or Shift+Page Down
keys.

Attempts to paste any of the following invalid values into the grid or Daily totals/Average row
results in the message: Cannot paste invalid values.

• Letters, special symbols, or negative values
• Decimal values for IV
• Values containing more than 9 digits for IV or Staffing
• Values that are out of range.

Shift+arrow keys
Click a cell in the grid and press:

• Shift+up arrow key to select additional cells above the selected cell.
• Shift+down arrow key to select additional cells below the selected cell.
• Shift+right arrow key to select additional cells to the right of the selected cell.
• Shift+left arrow key to select additional cells to the left of the selected cell.

Arrow keys
Click a cell in the grid and press:

• The up arrow key to select the cell immediately above it.
• The down arrow key to select the cell immediately below it
• The right arrow key to select the cell immediately to the right of it.
• The left arrow key to select the cell immediately to the left of it.

Click a range of cells in the grid and press:

• The up arrow key to select the cell immediately above the last cell in the range.
• The down arrow key to select the cell immediately below the last cell in the range.
• The right arrow key to select the cell immediately to the right of the last cell in the range.
• The left arrow key to select the cell immediately to the left of the last cell in the range.

Shift+Home, Shift+End
Click a cell in the grid and press:
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• Shift+Home to select additional cells to the left of the selected cell.
• Shift+End to select additional cells to the right of the selected cell.

This key combination has no effect on Time step column.

Home, End keys
Click a cell or range of cells in the grid and press:

• The Home key to select the first cell in that row.
• The End key to select the last cell in that row.

Shift+Page Up, Shift+ Page Down
Click a cell in the grid and press:

• Shift+Page Up to select all cells above the selected cell.
• Shift+Page Down to select all cells below the selected cell.

This key combination has no effect on Daily values row

Page Up, Page Down
Select cells in the grid, and press:

• Page Up to select the first cell in that column within the visible grid area.
• Page Down to select the last cell in that column within the visible grid area.

Clicking these keys selects only the cells within the visible area of the grid. Click these keys more
than once to select cells beyond the visible area.

Select a range of cells in the Daily totals row and press:

• Page Up to select the first cell within the selected range.
• Page Down to select the last cell within the selected range.

Ctrl+A

• Click any cell in the grid and press Ctrl+A—All cells in the grid are selected.
• Click any cell in the Timestep column and press Ctrl+A—All cells in the column are selected.
• Click anywhere in the Daily totals/Average row and press Ctrl+A—The entire row is selected.

Drag mouse or mouse pad

• Click any cell in the grid and hold down the right mouse key while dragging the mouse right, left, up,
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down, or any combination of directions. The range of cells is selected.
• Click any cell in the Time step column and hold down the right mouse key while dragging the mouse

up or down. The range of cells in the column is selected.
• Click anywhere in the Daily values row and hold down the right mouse key while dragging the mouse

left or right. The entire row is selected.

When dragging the mouse, if cells are selected beyond the visible area of the grid, the grid adjusts
and autoscrolls to display the selected cells.

Shift+ mouse-click

• Hold down the Shift key and click any cell in the grid. Using the mouse, click anywhere in the grid in any
direction. The range of cells is selected.

• Hold down the Shift key and click any cell in the Time step column. Using the mouse, click anywhere in
the column, up or down. The range of cells is selected.

• Hold down the Shift key and click anywhere in the Daily totals/Average row. Using the mouse, click
anywhere in the column, right or left. The entire row is selected.

Ctrl-C, Ctrl-V
Select cells in the grid, and press:

• Ctrl-C to copy values in the grid. The message Copied to clipboard appears. Click X to close it.
• Crtl-V to paste values in an Excel spreadsheet or a text editor such as, NotePad.

If more cells are copied than there are cells to paste into, WFM extends the number of cells/column/
rows to accommodate the data being pasted.
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Overlays

Tip
This page describes Overlays in the new Workforce Management (WFM) Forecast
module interface (introduced in 8.5.2). If you are using the classic Supervisors
interface and have landed on this page by accident, see the Workforce Management
Web for Supervisors Help (Classic), which describes the classic Forecast module,
including overlays.

In WFM, using overlays (previously named factors) enable you to factor in and track events that
might affect interaction volumes. Each event in an overlay represents an abnormality in historical
data or in the future—that is, a fluctuation in interaction volumes (IV) or average handling time (AHT)
that is not a usual seasonal, intra-week, or intra-day trend. Events that point to the same kind of
abnormality, one that has happened multiple times in the past or can happen in the future, can be
arranged into groups that are simply called overlays. The most common overlay examples are sales
promotions, advertising campaigns, and catalog drops.

Tip
You must have access permission to the Overlays view before you can view, create,
or modify overlays. See also, the Tip about access permission in Navigating the
Forecast views

Impact of overlay events on prediction data
It's important to understand the impact that overlays events make on prediction data. A forecast's
prediction data is directly impacted when a specific overlay event occurs over a prediction interval.
WFM uses one of two calculations to determine an overlay's impact on prediction data:

• Multiplicative—Increase (or decrease) every step of predicted data by a percentage. The percentage
is defined by overlay impact distribution, multiplied by the strength of the event. The duration of the
interval is affected by event changes.

• Overriding—Re-distribute (but does not change) the volume of an event's interval. The total volume
does not change, but it might be moved from one event-step to another.

For more information about overlay types and examples, see the Overlays Primer in the Workforce
Management Administrator's Guide.
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Opening the Overlays view

You create, edit, and delete overlays in WFM's Forecast module, by selecting Forecast > Overlays.

When you open this view initially, you might not see any overlays listed (see figure). WFM displays a
list of associated overlays only after you select a business unit or site in the Objects pane. If no
overlays exist for the selected object, you'll see the message No items to display. Either create an
overlay for the selected object or choose another object to view it's overlays.
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Working in the Overlays view

The Overlays view is split into three panes:

• Objects pane—Displays a hierarchical list of business units and sites in the enterprise. In this pane:
• Select a business unit or site (by clicking the arrow > beside the business unit) to see a list of

overlays for the selected object.

• Overlays pane—Displays the name of the selected business unit or site and a table containing its
overlays. In this pane:
• Select an overlay by type (Impacting or Redistributing) to display the tabs in the Data pane.
• Create an overlay, click New overlay in the toolbar.

If there are no overlays for the selected object, the message No items to display appears
in the middle of the pane.

• Delete overlays, check the boxes to select one or more overlays and click Delete in the toolbar.

• Data pane—Displays four tabs for the selected overlay: Properties, Distribution, Impacted activities, and
Events. In this pane:
• View or change the settings in any of these tabs.

The tab settings are described below.

Understanding the overlay's data

When you select an overlay in the Overlays pane, the four tabs associated with the overlay display
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in the Data pane. Click the Properties, Distribution, Impacted activities, or Events tab to display the
settings described in this topic.

Properties tab
The Properties tab settings and controls are described as follows:
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• Name field—You can edit the name in this field.
• This overlay is label—You'll see one of the following labels just below the Name field, depending on

the settings you chose when you created the overlay:
• This overlay is impacting forecast values and totals—Specify that this overlay can impact the

forecast by changing forecast’s values and totals. This option is the default.
• This overlay is redistributing forecast without changing totals—Specify that this overlay

must preserve a forecast’s total for specific period even while changing the distribution of values
inside that period.

• Spread over field—Displays the length of time that the selected Overlay will occupy. Edit this field
and select the Days, Hours, or 15 Minutes radio button. The value must be greater than 0 (zero) and
the default is set during creation.

• Use this overlay in the following way when building a forecast radio button group—One of these
two settings will be selected:
• Always use entered distribution—Use the specified (entered) distribution when building a

forecast. This option enables the Distribution tab.
• Always calculate disregarding impacts and distribution—Use this overlay, but always

disregard impacts and distribution when building a forecast. This option disables the Distribution
tab.

• This overlay is applicable to radio button group—One of the following settings will be selected:
• IV—Specify that this overlay applies only to Interaction Volume (IV).
• AHT—Specify that this overlay applies only to Average Handling Time (AHT).

Distribution tab
The settings you see on the Distribution tab depend on the choices you made in step 1 of the New
Overlay wizard or in the overlay's Properties tab. Specifically, this tab is disabled if Always
calculate disregarding impacts and distribution was selected in either place.
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If you selected Always use the entered distribution when creating the overlay:

• Graph—Displays the same information as the grid below it displays, but in graphical form.
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• Grid—Displays and allows you to edit the overlay's distribution. It contains the following columns in the
Daily or hourly impact section:
• Timestep—Each row displays an increment during which the overlay will be in effect. The actual

increment (timestep, day, or hour) is set in Properties tab.
• Distribution value—Displays the distribution value of each increment. The default value in each

cell is 0.
If the overlay is of the type:

• Impacting—You can enter values from -100 to 9999 into the grid. The top-most row in the
shows the Average value of all timesteps.

• Redistributing—You can enter a percentage into the grid from 0 to 100. The top-most row in
the grid shows the Total value of all timesteps.
If the Total does not equal 100 %, you will see a warning and will not be able to save
your changes to the overlay.
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Impacted activities tab

This tab lists all activities that correspond to the business unit or site that was selected in the Object
pane.

• Select one or more activities that will be impacted by the selected factor.
• Clear all check boxes to specify no impact.

Events tab
If there are no events for the selected overlay, you'll see only the Add events button and the
message There are no events to display. If events have been added, you'll see a grid listing all events
for the overlay, one per row. You can edit the value in every cell of this grid by clicking Actions >
Edit.
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The grid includes the following columns:

• Event—The name of the event.

• Actions icon—Clicking this icon opens a drop-down menu containing two actions for selection:
Edit and Delete.

• Start date—The start date of the event.
• Start time—The start time of the event.
• Strength—A coefficient (or multiplier) that measures the final impact of an event. The range is any

positive value (greater than zero), up to nine digits and two decimals.
• Disregard—If the check box is checked, the event disregards historical data. If unchecked historical

data is considered. See Ignoring historical data.

The Events tab includes the following controls:

• Add event button—Click to add an event.
• Cancel button—Click to cancel and discard changes.
• Save button—Click to save changes.

Ignoring historical data in overlays

Any event under an overlay type may have the Ignore Historical Data flag set, which specifies
whether the historical-data interval data that is covered by that event is used in calculations of
volume prediction or overlay impact (see Calculating Overlay Impact).

If an event does not have the Ignore Historical Data flag set, then the data that is covered by the
event is considered for prediction. There is no additional processing of historical data that is affected
by the event, other than ignoring it or using it.

Calculating an overlay's impact

The impact of an overlay is determined by analyzing historical data and by using WFM's prediction
algorithm. The algorithm analyzes the period of historical data, which contains one or more events of
overlay that are to be calculated.

Overlays can be precalculated before starting volume forecasting or during volume forecasting (see
"Event Impact Distribution" in the Workforce Management Administrator's Guide). Given the same
historical data and using the same method, the results should be identical.

Multiplicative overlays are calculated by separating the seasonal component (yearly, daily, or intra-
day) from the event impact for each event of the overlay in the given historical data. Then, the
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impact is divided by event strength and averaged. When the impact is applied to an event on the
prediction interval, it is multiplied by the strength of that event.

In Overriding Overlay, the percentage of each event-step in the total of the whole event period is
calculated for each event, and then averaged. See the following example:

A historical period has two events in a daily overlay, which is 3 days long. The days of the first event
are 150, 200, 150 (30%, 40%, and 30% of the total, respectively), and the days of the second event
are 150, 150, 200 (30%, 30%, and 40% of the total, respectively). Each event-step (in this case, a day)
is averaged individually, and the overlay is calculated as 30%, 35%, 35%, respectively.
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Managing overlays and events
Workforce Management (WFM) makes it easy to forecast and manage overlays and events in the
Forecast > Overlays view, by enabling you to:

• Create and delete overlays
• View and edit overlay data
• Add and delete overlay events
• View and edit event data
• Select overlay data to copy and paste
• Calculate the distribution in overlays

Tip
You must have the Overlays security permission to see Overlays in the Forecast
menu. Without this permission, you cannot create overlays and events, nor access
Overlays using a bookmarked URL. See "Forecast Role Privileges" in the Workforce
Management Web for Supervisors (Classic) Help.

Creating overlays

Use the New Overlay wizard to guide you through a simple two-step process.
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To create an overlay:

1. In the Forecast > Overlays view, select a business unit or site.
2. In the toolbar, click New overlay.

The New Overlay dialog opens.
3. In the Overlay name field, enter a name for the overlay (limited to 127 characters).
4. Choose the statistic for this overlay: IV or AHT.
5. In the Spread over field, enter a value, specifying either Days, Hours, or 15 Minutes.

The default is 1 and acceptable values are between 1 and 999.
6. Next, choose one of the following settings (choosing some settings in this section, will disable others):

• Select Impact Forecast values and totals (default), if you want this overlay to change the
forecast's values and totals. Then, choose one of the following:
• Always use the entered distribution
• Always calculate disregarding impacts and distribution

• Select Redistribute Forecast without changing total, if you want this overlay to preserve the
forecast's totals for a specific period, while changing the distribution of values inside that period.
Then, choose one of the following:
• Always use the entered distribution
• Always calculate disregarding impacts and distribution

7. If you choose Impact Forecast values and totals and then, Always use the entered distribution
in step 6, enter values for Initial impact and Ending impact.

8. Click Next.
9. In the Select activities dialog, expand the business units or sites to select activities and/or multi-site

activities for this overlay.
10. Click Create.
11. Click OK in the confirmation dialog.

You can click Cancel at any time to discard the settings and close the New Overlay wizard. Clicking
Cancel in the progress dialog, causes WFM to close the dialog and refresh the grid.

Rules for initial and ending impact
Keep the following information in mind when entering values for initial and ending impact in the
procedure Creating overlays:

• The Initial impact and Ending impact fields accept values from -100 to 9999.
• If you do not enter a value for both initial and ending impact, WFM creates 0.00 values in the

Distribution grid.
• If you enter a value in only one of the impact fields and the spread over value is 1, WFM creates the

distribution with the specified value.
• If you enter a value in only one of the impact fields and the spread over value is greater than 1, a
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validation message appears.
• If you enter different values in the impact fields and spread over is 1, a validation message appears.
• If you enter the values in both impact fields and spread over is 2, WFM creates the distribution with the

specified values.
• If you enter the values in both impact fields and spread over is greater than 2, WFM creates the

distribution by specifying the impact field values for the first and last timestep and calculates the
remaining timesteps values by using a formula.

Editing overlays

In the Overlay Distribution grid, you can move from cell to cell by using the Enter or Shift+Enter keys
on the keyboard. Click a cell and press:

• the Enter key to move the focus to the cell below the one selected.
• the Shift+Enter keys to move the focus to the cell above the one selected.

If you select a cell in the Average or Total row, you can use Enter to move down one cell, but you
cannot use Shift+Enter to move up one cell.

To edit an overlay:
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1. In the Forecast > Overlays view, select a business unit or site.
The overlays for this object are displayed in a table.

2. In the Overlays table, select the overlay you want to edit.
The Data pane opens, displaying four tabs.

3. Click a tab to change its settings.
4. Edit one or more of the tabs and click Save.

Alternatively, click Cancel at any time to discard any changes you've made.

Tip
When editing values in the overlay's Distribution tab, you can copy and paste data
from an Excel sheet by using Ctrl+C and Ctrl+V. See Selecting data to copy and paste.

Editing the Spread over value in the Properties tab
If you change the Spread over value in the Properties tab WFM enables you to update the
distribution values directly.
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After verifying the change to Spread over and clicking Save, you'll see this message in a
Confirmation dialog The distribution was reset due to the changes in spread over. Do you want to
enter a new distribution?

If you want to change the distribution:

1. Click Yes.
The distribution tab opens enabling you to proceed.

2. When you are finished making changes, click Save.
WFM verifies that the new spread over and distribution values were successfully saved.

If you do not want to change the distribution, click No. The Confirmation dialog closes and WFM
saves the new spread over value.
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Deleting overlays

Forecasts Overlays

Workforce Management Supervisor Help 187



To delete an overlay:
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1. In the Forecast > Overlays view, select a business unit or site.
The overlays for this object are displayed in a table.

2. In the table, select the overlay that you want to delete.

3. In the toolbar, click Delete .
4. When the confirmation dialog opens, click Delete to proceed or Cancel to cancel the action.

To delete multiple overlays at once:

1. Select the overlays you want to delete (using the check box beside each overlay).
2. Complete steps 3 and 4 in the procedure above.

To delete all overlays in the table:

1. Select the top-most check box in the column header (near the Name column header).
2. Complete steps 3 and 4 in the procedure above.

If you are deleting a single overlay, the confirmation dialog contains the overlay name. If you are
deleting multiple overlays, the confirmation dialog states the number of overlays being deleted.

Adding overlay events

Use the selected overlay's Events tab to add and manage overlays events.

Tip
This Help mentions three types of events, which are described in Understanding event
types.
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To add an overlay event:

1. In the Forecast > Overlays view, select a business unit or site.
The overlays for this object are displayed in a table.

2. In the Overlays table, select an overlay.
3. In the Data pane, click the Events tab.
4. Click Add event.

The New Event dialog opens.
5. In the Event name field, enter a name for the event.
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6. In the Impact start date and Impact start time fields, enter the date and time, or keep the default
date and time.

7. In the Strength field, you can enter a value or keep the default. The range is 0 to 999999999.99.
8. Alternatively, you can disable the value in the Strength field by selecting Disregard historical data.

If Disregard historical data is not selected, WFM considers historical data when processing
events.

9. Click Create.
10. When the confirmation dialog opens, click OK.

Alternatively, click Cancel at any time to cancel the action.
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Editing events

To edit an overlay event:

1. In the Forecast > Overlays view, select a business unit or site.
The overlays for this object are displayed in a table.

2. In the Overlays table, select an overlay.
3. In the Data pane, click the Events tab.
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4. In the row of the event you want to edit, click Actions and select Edit.
The Edit Event dialog opens.

5. Make the necessary changes and then, click Save.
6. When the confirmation dialog opens, click OK.

Alternatively, click Cancel at any time, if you want to cancel the action and discard the
changes.

Deleting events
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To delete an overlay event:

1. In the Forecast > Overlays view, select a business unit or site.
The overlays for this object are displayed in a table.

2. In the table, select an overlay.
3. In the Data pane, click the Events tab.
4. In the row of the event you want to edit, click Actions and select Delete.
5. When the Delete Event confirmation dialog opens, click Delete to proceed or Cancel to cancel the

action.

Calculating distribution in overlays

This procedure describes how to use the wizard to calculate an overlay's distribution. The wizard icon
is enabled only if the Always use the entered distribution setting is selected in the overlay's
properties. See Creating overlays.
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To calculate an overlay's distribution using the wizard:

1. In the Forecast > Overlays view, select a business unit or site.
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The overlays for this object are displayed in a table.
2. In the Overlays table, select an overlay (that has Always use the entered distribution selected).

3. Click Calculate Distribution .
The wizard open at Step 1.

4. Select an activity or multi-site activity and then, click Next.
Step 2 of the wizard opens.

5. Enter the Start and End date for the historical date range (use the up/down arrows or click the
calendar to select a date).
By default, WFM displays the start and end date of the historical date range for the selected
activity.

6. To select events, choose one of two radio buttons:
• Use all applicable events—Do nothing if you want all events to be considered when distribution is

calculated. This button is selected by default.
• Select events—Click this button if you want to select specific events.

1. Click Edit .
The Select Events dialog opens.

2. Click the check box beside an event if it should be considered for calculations and then, click
OK.
Clicking the top-most check box selects all events in the list.

The wizard returns to Step 2 and the Select events field shows the number of events you
selected.

7. Click Calculate.
When processing is complete, the Distribution tab shows the distribution for this overlay.

Click Cancel at any time in the wizard to cancel all actions and close the wizard dialog.

Selecting overlay events in the wizard
When selecting events in the Calculate Distribution wizard:

• If the selected activity does not have overlay events, you'll see the message You do not have any
overlay events.

• The dialog displays only events that fall within the selected historical date range.
• You can clear the events you selected in the Select Events dialog, by clicking x in the Select events

field when the wizard returns to Step 2.
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Selecting data to copy and paste

Tip
If you are unable to copy/paste, ask your administrator to confirm that your
environment is using HTTPS secure connections to WFM. See the Workforce
Management Administrator's Guide.

In the Overlays Distribution grid, WFM enables you to use key combinations on the keyboard to select
data for copying and pasting. You can copy/paste within the grid and to/from a document (for
example, Excel or NotePad).

Shift+arrow keys
Click a cell in the grid and press:

• Shift+up arrow key to select additional cells above the selected cell.
• Shift+down arrow key to select additional cells below the selected cell.
• Shift+right arrow key to select additional cells to the right of the selected cell.
• Shift+left arrow key to select additional cells to the left of the selected cell.

You must select the Total/Average row and the Time step column separately. They cannot be
selected with other rows or columns in the grid.

Shift+Page Up, Shift+Page Down
Click a cell in the grid and press:

• Shift+Page Up to select all cells above the selected cell.
• Shift+Page Down to select all cells below the selected cell.

Ctrl+A

• Click any cell in the grid and press Ctrl+A—All cells in the grid are selected.
• Click any cell in the Time step column and press Ctrl+A—All cells in the column are selected.
• Click anywhere in the Total/Average row and press Ctrl+A—The entire row is selected.

Drag mouse or touch pad

• Click any cell in the grid and hold down the right mouse key while dragging the mouse right, left, up,
down, or any combination of directions. The range of cells is selected.

• Click any cell in the Time step column and hold down the right mouse key while dragging the mouse
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up or down. The range of cells in the column is selected.
• Click anywhere in the Total/Average row and hold down the right mouse key while dragging the mouse

left or right. The entire row is selected.

You must select the Total/Average row and the Time step column separately. They cannot be
selected with other rows or columns in the grid.

Shift+ mouse-click

• Hold down the Shift key and click any cell in the grid. Using the mouse, click anywhere in the grid up or
down. The range of cells is selected.

• Hold down the Shift key and click any cell in the Time step column. Using the mouse, click anywhere in
the column, up or down. The range of cells is selected.

• Hold down the Shift key and click anywhere in the Total/Average row. Using the mouse, click anywhere
in the column, right or left. The entire row is selected.

You must select the Total/Average row and the Time step column separately. They cannot be
selected with other rows or columns in the grid.

Ctrl+C, Ctrl+V
Select cells in the grid, and press:

• Ctrl+C to copy values in the grid. The message Copied to clipboard appears. Click X to close it.
• Crtl+V to paste values in an Excel spreadsheet or a text editor such as, NotePad.

If more cells are copied than there are cells to paste into, WFM extends the number of cells/column/
rows to accommodate the data being pasted.
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Common forecasting tasks
In some cases, Workforce Management (WFM) enables you to complete the same task in more than
one Forecast view. In this topic, you'll find descriptions and procedures to help you complete these
common tasks.

Adding and removing activities

Add or remove activities or multi-site activities (MSA) in open scenarios by using the Add activities
and Remove activities icons in the toolbar in all Scenarios views (Volumes, Staffing, Shrinkage).

Adding activites or MSA

To add activities or MSA to an existing forecast:

1. Open a scenario.
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2. In the toolbar, click Add activities .
The Add activities dialog open.

3. Expand the tree to select the activities you want to add.
You can select from multiple sites.

4. Click Add.
5. When processing is complete, click OK.

Click Cancel at any time to cancel the action and close the dialog.

Removing activities or MSA

To remove activities or MSA from an existing forecast:

1. Open a scenario.
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2. In the toolbar, click Remove activities .
The Remove activities dialog open.

3. Expand the tree to select the activities you want to remove.
You can select from multiple sites.

4. Click Remove.
5. When processing is complete, click OK.

Click Cancel at any time to cancel the action and close the dialog.

Saving forecasts as templates

Reuse data in an existing scenario or Master Forecast by using the Save as Template wizard to
create a forecast template. You can use this wizard in all Scenarios and Master Forecast views.
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To save the forecast as a template:

1. Open a scenario or Master Forecast.
2. In the Objects pane, select an activity or multi-site activity (MSA).

This enables the Save as template option.
3. In the top-right corner of the view, click the down arrow on the Save button.
4. When the drop-down menu opens, select Save as template....

The Save As Template dialog opens.
5. In the Name field, enter a name for the new template.
6. Select the template type from the Type drop-down list (IV or AHT if opened in the Volumes view).

This field has a prepopulated value that cannot be changed when you open this dialog in the
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Staffing or Shrinkage view.
7. Select or enter the Source start date and Source end date into the corresponding fields.
8. Expand the list of objects on the right to select activities or multi-site activities to use for this template

and click Save.
9. When the saving process is complete, click OK.

The new forecast template appears in the Templates view.
10. Alternatively, click Cancel to cancel the action and close the dialog.

Commenting in forecasts

Add, open, edit, delete, and sort comments in scenarios or Master Forecasts by using the Comments
dialog. You can open this dialog in all Scenarios and Master Forecast views. Watch the video.

Tip
Comments added in the Web for Supervisors (Classic) Forecast module are visible in
this Forecast module. However, comments added in this Forecast module are not
visible in the (Classic) Forecast module.
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Adding and opening comments

To add comments to a forecast:

1. Open a scenario or Master Forecast view.
2. In the Objects pane, expand the tree and select an activity or multi-site activity.
3. In the grid, select a cell in the date column where you want to add comments.
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4. Click Comments in the upper-right corner of the view.
The Comments pane opens.

5. Click Add comment.
6. Enter your comment in text field (2000 characters, maximum) and click Comment.

The comment displays on the Selected tab.

After adding comments for a specified date:

• If the selected period is weekly, the column header in the grid displays in yellow. A triangle in the upper-
right corner indicates that there are comments for that date.

• If the selected period is monthly or yearly, the cells in the row for that date appear in yellow with the
triangle in the upper-right corner.

• In the upper-right corner of the view, the Comments icon shows the total number of comments in red
for the selected activity or multi-site activity.

Link to video
Open the Comments pane in one of two ways:

1. Click the triangle in the date cell.
The Selected tab opens, by default.

2. Select an activity and then, click Comments in the upper-right corner of the view.
The All comments tab opens, by default. If there are no comments for the selected activity,
the No comments message displays.

If you select a range of date cells, the Selected tab opens displaying the comments for the first
selected date. If you select a date cell that has no comments, the Selected tab opens displaying No
comments.

If there is more than 3 lines of text, click More to see the entire comment. Click Less to hide it.

Close the Comments pane by clicking the X in the upper right corner of the pane.
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Editing, deleting, and sorting comments

To edit comments:

1. Open the Comments pane.

2. In the comment you want to edit, click Actions to open the drop-down menu.
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3. Select Edit.
4. When the text box opens, edit the comment.
5. Click Save.

You can edit only the comments you created. If you click a comment created by someone else,
Delete is the only option displayed in the Actions menu.

To delete comments:

1. Open the Comments pane.
2. In the comment you want to delete, click Actions to open the drop-down menu.
3. Select Delete.
4. When asked to confirm the deletion, click Delete.

To sort comments:

1. Open the Comments pane.
2. Select the tab you want to sort.
3. In the Sort by field, click the down arrow to open the menu.
4. Select one of four sort criteria: Recent First, Oldest First, User, Asc, or User, Desc.

The list of comments sorts according to the selected criteria.

The Sort by field is visible only if there are two or more comments in the tab. Selecting User, Asc or
User, Desc sorts comments by the user's name in ascending or descending order. Recent First is
the default sort order.

Click Cancel at any time to cancel the action when adding, editing, and deleting comments.

Using Search to find objects

Find activities quickly in Scenarios and Master Forecast views by using Search in the Objects pane.

Click the icon at the top of the Objects pane to show or hide the Search field. You can use this
search function in all Scenarios and Master Forecast views.
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To use search to find objects quickly:

1. Open any one of the Scenarios or Master Forecast views.

2. If you are in the Scenarios view, click the Actions menu and open a scenario.

3. In the Objects pane, click Search .
The Search field is displayed.

4. Enter the search criteria. For example, the name of an object (business unit, site, activity, multi-site
activity).
WFM highlights any matching text as you type.

5. Click Enter.
WFM expands the list to show the number of matching objects found and shows the number
of matching items in the Search field, together with up/down arrows.

6. Click the up or down arrow until you find the object you're searching for.
7. Click x to clear the Search field and start a new search.

If WFM does not find matches for the search criteria you've entered, WFM displays 0 of 0 found and
no text is highlighted in the list of objects.
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Master Forecasts

Tip
This page describes Master Forecasts in the new Workforce Management (WFM)
Forecast module interface (introduced in 8.5.2). If you are using the classic
Supervisors interface and have landed on this page by accident, see the Workforce
Management Web for Supervisors Help (Classic), which describes the classic Forecast
module, including the Master Forecast.

WFM Master Forecast consists of the volumes and staffing data that is built on forecast scenarios that
have been published. Here's what you'll find in these views:

• Master Forecast Volumes—Interaction volumes (IV) and average handle time (AHT) data.
• Master Forecast Staffing—Calculated and required staffing data.
• Master Forecast Shrinkage—Overhead data, which WFM uses to forecast shrinkage while scheduling.

Note that the Forecast > Scenarios view also has Volumes, Staffing and Shrinkage views. These
views are similar, but in some ways different from the Master Forecast views. For example, you might
create several forecast scenarios containing volumes, staffing, and shrinkage data before choosing
one that is optimal for publishing to the Master Forecast.

Viewing the volumes data

Use the Forecast Volumes view in the Master Forecast to display the interaction volumes (IV) and
average handle time (AHT) data. When you select an object in this view, the start date is determined
by the selected business unit's week start day setting, regardless of your locale settings.

This view provides standard date-selectors and a grid that shows statistics for days or timesteps.

Link to video
To open the Volumes view in the Master Forecast:

1. In the navigation bar, select Forecast > Volumes.
2. In the Objects tree, expand a business unit to select a site, activity, or multi-site activity.

The view displays a graph above a table, each containing the same statistics and controls that set
the data display properties.
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If you do not see any volumes data, you can adjust the Period drop-down list, the sliders (below the
graph), or the Granularity and date-selectors at the top of the window to reflect those used for the
forecast.

The grid displays open hours for selected site activities and multi-site activities in the same way.

You can view the staffing or shrinkage data in the Master Forecast, by selecting Staffing or Shrinkage
from the drop-down list in the top-left corner of this view.

Setting the data display properties

In this view, use the following controls to customize the data display:

• Primary statistic drop-down list—Select the statistic that will be displayed as primary, by selecting
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Interaction Volume (IV) or AHT (average handle time). The primary statistic displays as a bar in the
graph and the secondary statistic displays as a red line.

• Granularity drop-down list—Select Month or Year to adjust the granularity to Day. Select Week to
further adjust each row's time range by selecting 15, 30, or 60 (minutes) from this list.

• Period drop-down list—Change the time range for the graph and grid by selecting Year, Month, or
Week. If the selected site has a configured planning period, you can also select Planning Period.

• Date range—Use the date-selectors (top-right portion of the view) to switch to a different period within
the scenario forecast's date range. The week number is also displayed here when the selected period is
Week.

• Actions drop-down menu—Click this icon to change the graph and/or table:
• Graph options—Show/hide the graph and zoom bar by selecting/clearing the Show graph check
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box. See also Sliders.
• Show columns—Show/hide data columns in the table by selecting/clearing the following check

boxes:
• IV forecast #
• IV forecast %
• IV actuals #
• AHT forecast #
• AHT actuals #

Click anywhere in the view to close the drop-down menu.
• Toggle statistics/events check boxes—Below the graph, toggle a statistic or applied events on or off.

Selecting the check box or clicking the radio button toggles it on, displaying the primary statistic as
bars, the secondary statistic as a red line, and applied events as a striped orange line. Clearing the
check box or clicking the radio button toggles it off, making the statistic or event invisible in the graph.
When turned on, the primary statistic's radio button is light blue and the Applied events button is
yellow.

Tip
Applied events are events that have been added to Overlays and the striped orange
line represents the start of the event’s impact for that period.

Link to video
Watch the video demonstrating how following features (described here and shown in the graphics
above) work. The Smooth graph feature described in the first half of the video is not available In the
Master Forecast views:

• Sliders—Drag the vertical slider left/right to show/hide the graph, zoom bar, grid and/or Objects pane.
Click the arrows in the vertical slider to resize the Objects pane. Drag the horizontal slider up and
down to show/hide the graph or grid.

• Zoom bar graph—Use the zoom bar handles to narrow/widen the focus in the graph, by sliding the
handle left/right. You can zoom to a minimum of one day. After narrowing the focus, place your cursor
over the graph and change the range of the zoom by dragging and dropping it to the left or right. For
example, if you narrow the focus to Sunday, Monday, and Tuesday, but want to change it, drag and
drop the zoom to the right to Tuesday, Wednesday, Thursday.

Reading the volumes data
The graph shows the statistics, dates, period, and granularity that you selected above. The vertical
axis indicates the primary statistic on the left and the secondary statistic on the right. The horizontal
axis indicates the different units for the two statistics.

To understand the volumes data, see Reading the data in the Scenario > Volumes topic.
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Editing the volumes data
In the Master Forecast > Volumes grid, WFM enables you to edit values in the Actual columns only
(Actual IV and Actual AHT). You can edit timesteps and daily totals when the selected period is
Week and edit weekly and daily totals when the selected period is Month or Year.

You must have the Forecast access privilege Edit Historical Data to edit values in the Actual
columns.

When changing the period, granularity, and/or values in the grid, note that daily totals are
aggregated values for a 24-hour period. This means the daily and weekly totals automatically adjust
and are redistributed according to the original distribution of volume for each day of the week or
week of the month/year.

Find information about editing modes and see the editing procedure in Editing data in the grid in the
Scenarios > Volumes topic.

Copying and pasting the volumes data
In the Master Forecast > Volumes grid, WFM enables you to copy and paste values to/from the
actual columns only (Actual IV and Actual AHT). When selecting data for pasting, if you select cells
in non editable columns, such as IV Forcasted #, only the cells in Actuals # columns are pasted.

You must have the Forecast access privilege Edit Historical Data to copy/paste data in this view.

For more information about copying and pasting volumes data, see Selecting data to copy and paste.

Viewing the staffing data

Use the Forecast Staffing view in the Master Forecast to display the required and calculated
staffing data. This view provides standard date-selectors and a grid that shows statistics for days or
timesteps.

Link to video
To open the Staffing view in the Master Forecast:

1. In the navigation bar, select Forecast > Staffing.
2. In the Objects tree, expand a business unit to select a site, activity, or multi-site activity.

The view displays a graph above a table, each containing the same statistics and controls that set
the data display properties.

If you do not see any staffing data, you can adjust the Period drop-down list, the sliders (below the
graph), or the Granularity and date-selectors at the top of the window to reflect those used for the
forecast.
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The grid displays open hours for selected site activities and multi-site activities in the same way.

You can view the volumes or shrinkage data in the Master Forecast, by selecting Volumes or
Shrinkage from the drop-down list in the top-left corner of this view.

Setting the data display properties

In this view, use the following controls to customize the data display:

• Primary statistic drop-down list—Select the statistic that will be displayed as primary, by selecting
Calculated staffing or Required staffing. The primary statistic displays as a bar in the graph and
the secondary statistic displays as a red line.

• Granularity drop-down list—Select Month or Year to adjust the granularity to Day. Select Week to
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adjust the granularity to 15, 30, or 60 (minutes).
• Period drop-down list—Change the period or time range for the graph and grid by selecting Year,

Month, or Week. If the selected site has a configured planning period, you can also select Planning
Period.

• Date range—Use the date-selectors (top-right portion of the view) to switch to a different period within
the scenario forecast's date range.

• Actions drop-down menu—Click this icon to change the graph and/or table:
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• Graph options—Show/hide the graph and zoom bar by selecting/clearing the Show graph check
box. See also Sliders.

• Show columns—Show/hide data columns in the grid by selecting/clearing the Calculated
staffing, Required staffing or Secondary data check boxes.

• Secondary data—Click this item to open a fly-out menu that list all of the secondary data types
that can be displayed in the graph and grid.
If Secondary data is checked in the Show columns section, the data type that you select
from the fly-out menu is the name of the column that displays in the grid and the radio
button/check box below the graph, and it displays as the y-axis statistic. To learn more,
see Viewing the staffing secondary data.

Click anywhere in the view to close the drop-down menu.
• Toggles check boxes—Below the graphic, toggle a statistic (Calculated, Required, Secondary data),

or Applied events on or off in the graph. Selecting the check box or clicking the radio button toggles it
on, and clearing the check box or clicking the radio button toggles it off. When checked, the radio
button is:
• solid blue for Calculated.
• outlined in magenta for Required.
• outlined in a broken purple line for Secondary data.
• outlined in a broken yellow line for Applied events.

Watch the video demonstrating how the Sliders and Zoom bar graph (shown in the graphics above)
work. The Smooth graph feature described in the first half of the video is not available In the Master
Forecast views.

Reading the staffing data
The graph shows the staffing, dates, period, and granularity that you selected above. The vertical
axis indicates the number of agents staffed. The horizontal axis displays different units for the
staffing data.

To understand the staffing data, see Reading the data in the Scenario > Staffing topic.

Viewing the staffing secondary data
In the Master Forecast > Staffing view, you can view secondary data in the graph and grid, in any
granularity (Day, 15, 30, 60 minutes) and for any period (Week, Month, Year). Note that secondary
data column in the grid is read only, and fixed-staff activities and multi-site activities do not have
secondary data.

Displaying and viewing secondary data in the Master Forecast > Staffing view is the same as
described in the Scenarios Staffing topic.
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Editing the staffing data
In the Master Forecast views, if you select the period Year or Month, you can click inside the
Weekly Totals cells in the grid and edit the value there. Find information about editing modes and
see the editing procedure in Editing data in the grid in the Scenarios > Staffing topic.

Copying and pasting the staffing data
In the Master Forecast > Staffing grid, WFM enables you to copy values from the Calculated and
Required columns and paste them to external documents, such as Excel or Notepad. You cannot
paste data in this view.

For more information about copying and pasting staffing data, see Selecting data to copy and paste.

Viewing the shrinkage data

Use the Forecast Shrinkage view in the Master Forecast to display the overhead data, which WFM
uses to forecast shrinkage while scheduling. This view provides standard date-selectors and a grid
that shows statistics for days or time steps.

Link to video
To open the Shrinkage view in the Master Forecast:

1. In the navigation bar, select Forecast > Shrinkage.
2. In the Objects tree, expand a business unit to select a site, activity, or multi-site activity.

The view displays a graph above a table, each containing the same shrinkage data and controls that
set the data display properties.

If you do not see any shrinkage data, you can adjust the Period drop-down list, the sliders (below the
graph), or the Granularity and date-selectors at the top of the window to reflect those used for the
forecast.

The grid displays open hours for the selected site activities and multi-site activities in the same way.

You can view the volumes or staffing data in the Master Forecast, by selecting Volumes or Staffing
from the drop-down list in the top-left corner of this view.
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Setting the data display properties

In this view, use the following controls to customize the data display:

• Shrinkage type drop-down list—Select the shrinkage type to be displayed by selecting Grand total,
Total planned, or Total unplanned.

• Period drop-down list—Change the period or time range for the graph and grid by selecting Year,
Month, or Week. If the selected site has a configured planning period, you can also select Planning
Period.

• Granularity drop-down list—Adjust the granularity to Day if you selected Month or Year in the
Period drop-down list. Adjust the granularity to 15, 30, or 60 (minutes) if you selected Week in the
Period drop-down list.

• Date range—Use the date-selectors (top-right portion of the view) to switch to a different period within
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the scenario forecast's date range.

• Actions drop-down menu—Click this icon to change the graph and/or table:
• Graph options—Show/hide the graph and zoom bar by selecting/clearing the Show graph check

box. See also Sliders.

Watch the video demonstrating how the Sliders and Zoom bar graph (shown in the graphics above)
work. The Smooth graph feature described in the first half of the video is not available In the Master
Forecast views:

Reading the shrinkage data
The graph shows the shrinkage type, date, period, and granularity that you selected above. The
vertical axis indicates the shrinkage percentage. The horizontal axis displays different units for the
shrinkage.

To understand the shrinkage data, see Reading the data in the Scenarios > Shrinkage topic.

Editing the shrinkage data
In the Master Forecast views, if you select the period Year or Month, you can click inside the
Weekly Totals cells in the grid and edit the value there. Find information about editing modes and
see the editing procedure in Editing data in the grid in the Scenarios > Shrinkage topic.

Copying and pasting the shrinkage data
In the Master Forecast > Shrinkage grid, WFM enables you to copy values from the columns in the
grid and paste them to external documents, such as Excel or Notepad. You cannot paste data in this
view.

For more information about copying and pasting shrinkage data, see Selecting data to copy and
paste.

Finding events in forecasts

Find events for an activity or multi-site activity quickly by using the Find Events search dialog,
available only in the Master Forecast > Volumes view.

When a Find Events search is initiated, WFM searches through historical data for any period of time
that represents an anomaly. For example: imagine that the AHT on May 24, 2008, between 8 p.m.
and 9 p.m. was 500% higher than on the historical norm for those hours. The Find events search
dialog can quickly locate this anomaly in the historical data for you, when it might otherwise be hard
to find.
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The Find events dialog opens with Possible events selected by default and contains the default
values for the statistic, granularity, and start and end dates based on the Master Forecast Volumes
primary statistic, granularity, and date range. You can change any of these default settings.

Understanding event types
This Help mentions three types of events, as follows:

• Applied events—You apply these when you are building volumes. These events are equal to or a subset
of Existing events.

• Existing events—You define or add these in the Overlays view.
• Possible events—WFM calculates these using the Find events feature (described in this topic), based on

historical data.

When selected in the results pane, Possible events appear in a yellow bar graph and Existing
events appear in a stripped pink bar graph.

Events can sometimes overlap. When this happens, hover your cursor over the overlapping area or
non-overlapping area to display the event name and date.
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To find events in a forecast:

1. Open the Master Forecast.
2. In the Volumes view, expand business units and sites in the Objects pane and select an activity or

multi-site activity.

3. Below the date range, in the toolbar, click Find events .
The Find events dialog opens.

4. Retain the defaults, or select the Data type (IV, AHT) and Granularity (Daily, Hourly) on which to
search.

5. Retain the defaults, or select a Start date and End date.
6. Enter the Threshold percentage (between 1 and 1000).

This is the percentage of deviation from historical data, that would identify the event you
want to locate.

7. Click Find events.
When WFM completes the search, the dialog displays the results in two categories with the
number of events found in brackets:
• Possible events (<n>)
• Existing events (<n>)

Click either radio button to see the result for that category.

Items in both results lists display in the format <start date and time - end date and time>. Existing
events items also show the event name above the date/time range.

Selecting an event in the either list changes the primary statistic, granularity and date range in the
toolbar, if applicable. If there are no events to display, you'll see the message You do not have any
overlay events.

In the results dialog, you can also:

• Start a new search, by clicking the arrow (<) beside New search.
• Show/hide the search criteria in the results dialog by clicking Show or Hide.
• Create an overlay, by clicking New overlay (enabled only if Possible events is selected).

This action opens the New Overlay wizard.
• Create an event, by clicking New event (enabled only if Possible events is selected).

This action opens the New Event wizard. It contains a list of overlays and default values that
are based on the search criteria. New events appear in the existing events list if it falls
within the date range. If you enter an event name that already exists, WFM displays an
error message in the New Event dialog.

• Close the dialog, by clicking the X in the upper-right corner.
• Cancel the search, by clicking Cancel or X in the upper-right corner of the progress dialog. WFM

preserves your selections in the Find events dialog.
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Cleaning up data in the forecast

From time to time, you might need to remove information from the Master Forecast for specific dates,
activities, or multi-site activities (MSA). WFM simplifies this task by providing the Cleanup feature in
all three Master Forecast views. You can clean up data for one or more business units, sites, activities,
or MSA.

Warning
Be careful when using this feature. It deletes all of the saved data for the selected
date range and activities or MSA. Genesys recommends that you do not use the
Cleanup feature unless it is absolutely necessary. If you must remove Master Forecast
data, Genesys recommends that you first extract the data to a forecast scenario
(using the Publish or Extract wizard), and/or make a backup of the WFM database.
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To remove data from Master Forecast for a specified date range:

1. Open a view in the Master Forecast (Volumes, Staffing, or Shrinkage).
2. Click Cleanup.

The Cleanup Master Forecast dialog opens.
3. In the Start date and End date fields, enter (or select from the calendar) the range of dates for which

you want to remove data.
4. Expand the tree to select the business units, sites, activities, or MSA for which you want to remove data.
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5. Click Cleanup.
6. In the Cleanup dialog, if you are sure you want to complete this action, click Cleanup.
7. When the dialog indicates that the process is complete, click OK.

Click Cancel or X in the upper-right corner at any point to close the dialog without changing the
Master Forecast.

Important
If you click Cancel or X when the cleanup is in progress, WFM might or might not
preserve the data, depending on how much of the process is complete.

Using the toolbar

You can use the following buttons on the toolbar in all Master Forecast views:

Icon Name Description

Copy Copies data selected in the grid
to the clipboard.

Cleanup

Opens the Cleanup Master
Forecast dialog, enabling you to
remove data from the Master
Forecast for selected dates,
activities, or multi-site activities.
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Performance

Tip
This page describes the new Workforce Management (WFM) Performance module
interface (introduced in 8.5.2). If you are using the classic Supervisors interface and
have landed on this page by accident, see the Workforce Management Web for
Supervisors Help (Classic), which describes the classic Performance module.

Performance page allows you to view performance statistics for business units, sites, and activities:

• Monitor view, for the most recently completed timestep
• Intra-Day table view
• Alerts view

For more information, see Performance.
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